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Introduction to the MobileMapper System
The MobileMapper system from Thales Navigation is com-
posed of two main elements: the MobileMapper receiver and 
MobileMapper Office software running on a PC-type com-
puter.
The MobileMapper receiver is a handheld navigation and 
positioning device that enables you to describe the features 
being mapped and then format the data so that later it can be 
uploaded to a GIS. It offers an easy-to-use and easy-to-de-
ploy solution for general mapping and for asset manage-
ment.
MobileMapper combines all the navigation capabilities of a 
recreational handheld with feature attributing software to 
support GIS data collection in the field.
The MobileMapper receiver and its main functions are fully 
described in Section 1 in this manual.

MobileMapper Office is an office software suite that inter-
faces the MobileMapper receiver with your GIS system. Mo-
bileMapper Office allows you to prepare GIS jobs, feature 
libraries and waypoint files, build background maps from 
GIS data files and manage the information logged in the field 
(upload/download functions).
The MobileMapper Office software and its mains functions 
are fully described in Section 2 in this manual.
All functions relative to data exchange between MobileMap-
per and MobileMapper Office are also detailed in Section 2.

Finally, the Appendices section in this manual covers a num-
ber of topics such as product specifications, SD card instal-
lation, connectors & cables and glossary of terms used.

Please note that a printed Getting Started Guide is included 
in your MobileMapper system. This short, multilingual 
guide, which is presented in a tutorial form, is intended to 
help you complete your first job. Practising with this guide 
will allow you to understand the essentials of the system. 
1
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1. MobileMapper Field Unit
Keypad Description
Under the screen you will see 8 buttons located around a 
large oval “scrolling” button with 4 directional arrows on it.
IN/OUT: Use these but-
tons to zoom in and out 
when viewing a screen 
with a map displayed.
ESC: Takes you back to 
the previous screen with-
out effecting any changes.
NAV: Takes you to the 
various navigation 
screens where you can lo-
cate yourself and navigate 
to waypoints and GIS fea-
tures.
LOG: Lets you create a 
new job or open an exist-
ing one. With a job and a 
feature already open, 
pressing LOG takes you to 
the feature attribute screen. With an open job, but no open 
feature, pressing LOG takes you to the feature selection 
screen.
ENTER: Use this button to accept highlighted input and to 
initiate various unit functions.
MENU: Provides access to a variety of functions such as set-
ting up and initializing the receiver, selecting targets to nav-
igate to and various GIS logging features.
PWR button: Turns on and off the unit. Also turns the back-
light on if you hold it down for two seconds (until the back-
light level changes).

IN OUT

ESC

MENU

PWRLOG

NAV

ENTER

Display

GPS antenna (inside the housing)

Screen

Scrolling button
The scrolling button
has three different

functions:
• It is used to move the

cursor in the chosen
direction, from a data

field to another, from an
option in a menu to the

previous or next option.
• In a highlighted field,

the left/right arrow
moves the cursor back-
ward/forward; The up/

down arrow increments/
decrements the high-

lighted figure or string.
• On the Map screen, a
navigation screen, this

button allows you to
switch to cursor mode

and then to move the cur-
sor in ALL directions, not

only the left, right, up
and down directions.
3
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Installing the Batteries
MobileMapper uses two AA 
batteries that are installed 
from the back through the bat-
tery cover. To remove the bat-
tery cover, push the two 
buttons on the cover fully to 
the left and lift the battery 
cover away from the receiver.
Insert the new batteries as 
shown opposite, making sure 
that the batteries are installed with the correct polarity. Re-
place the cover and push the two buttons fully to the right. 
Verify that the cover is locked in place.

Turning Power On/Off
In the Power-On procedure described below, it is assumed 
that the unit has already been used in a working session and 
so position data is available from the former working session 
to help MobileMapper compute its position.
• To turn the unit on, press the PWR button. The Start-up 

screen appears, followed by the Database Copyright 
screen and the Agreement screen. After accepting the 
warning information, the last navigation screen you were 
viewing at the end of the last session will be displayed.
If the last navigation screen view was the Map screen, 
the last zoom scale setting will be used.

• To turn the unit off, press the PWR button. The Power 
Down screen is displayed.
Doing nothing will turn off the unit at the end of the 
countdown sequence.
Pressing the PWR button again will turn off the unit 
immediately.
Pressing ESC will cancel the Power Down sequence. 
Battery Life
You can expect up to 16
operating hours from 2

Li-ion AA batteries with
the backlight turned off.
Using the backlight will

shorten the battery life
significantly. With the
backlight on continu-
ously, you can expect

about up to 8 hours of
usage from the two Li-ion

batteries that came with
your MobileMapper.

The very first time you
use your MobileMapper,

or after erasing all the
data from memory, the

Power-On procedure is
longer than described
here because the unit
having no position in

memory, initialization is
needed to help the unit

track satellites (see 1st-
time use on page 6).

Power Down Screen
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Setting the Screen Backlight
The screen backlight can be set to one of three levels (low, 
high or off). At power on, the screen backlight is set to high 
level. Follow the sequence below to choose another level:
- Hold down the PWR button for 2 seconds : Backlight 

drops down to low level
- Hold down the PWR button again for 2 seconds: Back-

light turns off.
- Hold down the PWR button again for 2 seconds: Back-

light comes back to high-level illumination.
Using the backlight makes the screen display easier to see, 
but it also drains the batteries more quickly.

Setting the Units
To change the units that MobileMapper will use:
- Press MENU. Use the up/down arrows to highlight Setup 

and press ENTER
- Use the up/down arrows to highlight Units and press 

ENTER.
- Use the up/down arrows to highlight the set of units you 

want and press ENTER. Press ESC to return to the last 
screen viewed

Getting a Position Fix
The unit is designed to fit comfortably in your hand. Hold 
the MobileMapper in the palm of your hand with the antenna 
pointing towards the sky.
MobileMapper’s antenna needs to have a relatively unob-
structed view of the sky. This allows the unit to choose from 
all satellites currently available.
If the view of the sky is poor due to large cliffs or buildings, 
heavy foliage or other obstructions, the satellite signals can 
be blocked and the receiver may take longer to compute a 
position fix.
To prevent accidently
turning the backlight on

and leaving it on, the unit
will turn the backlight off
when there have been no

buttons pressed for 4
minutes. Pressing any

button will turn the back-
light back on in this

instance. You can change
the time delay for the

backlight using the Light
Timer option in the Setup

menu (see page 56).

Units Screen

Holding the unit

You can observe the sig-
nal strength and the sat-
ellites being used on the

Satellite Status screen
(see page 8).
5
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Initialization for First-Time Use
MobileMapper will walk you through the process of setting 
up the receiver for first time use. This procedure is common-
ly referred to as “Initializing the Receiver”. The purpose of 
this initialization is to provide MobileMapper with a general 
knowledge of its approximate location.
This may seem a little confusing at first as why does a device 
that is used to compute its position need to know where it’s 
at? MobileMapper uses information from the GPS satellites 
that orbit the Earth and if MobileMapper has an approximate 
idea as to its location, it will refer to the almanac it has in 
memory to select what satellites are overhead. From this in-
formation, MobileMapper can then select the satellites that 
will give it the best information for computing its location.
Under normal use, MobileMapper will save the last position 
it calculated and use that position the next time it is turned 
on. However, when MobileMapper is new (or when memory 
has been completely erased), it has no last position informa-
tion. Thus, MobileMapper can either start polling the satel-
lites to see which ones are overhead or you can provide it 
with your approximate location allowing MobileMapper to 
begin computing the initial position, known as “first fix.”

Follow these instructions to initialize MobileMapper:
1. Turn MobileMapper on by pressing the PWR button. The 

unit turns on and displays the start-up screen, followed 
by the Database Copyright screen and the language 
selection screen.

2. Select your language using the up/down arrow to move 
the cursor to this language. With the desired language 
highlighted, press the ENTER button. The Warning 
screen is then displayed for about 10 seconds.
Skipping Initialization
You can skip the initial-

ization process by press-
ing the NAV key anytime

after selecting the lan-
guage you want

MobileMapper to use
and accepting the agree-

ment. If MobileMapper is
able to collect satellite
data (i.e., have a clear
view of the sky) it will
begin to self-initialize.

This could take anywhere
from 3 to 14 minutes to

compute its position,
depending on how many

weeks have elapsed since
it was last used.

Start-up, Copyright &
Language Screens
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3. If you understand and agree to the warning presented, 
press ENTER before the 10 seconds have elapsed. Other-
wise, the unit will shut off. A message box is then dis-
played indicating that the unit needs to be initialized.

4. Press ENTER. The unit asks you to select your region 
and area. Use the up/down arrows to highlight your gen-
eral region and press ENTER. Again, use the up/down 
arrows to highlight your area and press ENTER.

5. The cursor appears in the Time field, waiting for you to 
input your local time. Please enter the time in 0-12 hr. 
format, not in 0-24 hr. format. Set your local time using 
the arrow keys as follows: use the up arrow to increment 
the highlighted figure, or the down arrow to decrement it. 
Then press the right arrow to highlight the next figure. 
Set this figure now using the up or down arrow, etc. Be 
sure that you set the AM/PM indicator. When the time is 
correct, press ENTER.

The last piece of information needed is the date. As 
above, using the arrow keys, enter the present date and 
then press ENTER.
All the information that the unit needs to speed up the 
process of computing its first fix has been entered and 
the Done field is highlighted.
Region & Area Screens
 

Time & Date Screens
7
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6. To complete the initialization process, press ENTER 
again. The Satellite Status screen is displayed and 
MobileMapper begins acquiring the data from satellites.
Watching the bars appear and turn solid on the screen, 
you can progressively see the unit lock onto satellites.

Once the first position fix has been computed, the Map 
screen is automatically displayed. This screen shows a 
map of the area where you are located. Your current posi-
tion is represented by a triangle located at the center of 
the screen (see also page 26).
Initialization is now complete and you can proceed to 
your job.

Satellite Position Graph

Satellite Signal Strength Chart

Battery Life Indicator

Satellite Positions

(W for WAAS
in the Sky & Numbers

or EGNOS)
Satellite Signal
Strength Chart:

Clear bars indicate that
the unit is starting to get

information from satel-
lites. Solid bars indicate

that the satellites are
being used to compute

your position.

Satellite Position
Graph:

The 2 circles indicate
satellite elevation as seen

from your current posi-
tion. The outer circle rep-

resents the horizon and
the inner circle repre-

sents 45° from the hori-
zon. The center of the
circle is 90° from the

horizon, or directly over-
head.
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GIS Data Logging Functions
Feature Libraries
Feature libraries contain lists of features that you should be 
visiting during your field sessions.
Features are four types:
- Point feature: The geometrical representation of this fea-

ture is a point. Logging this type of feature requires static 
occupation at the point.

- Line feature: The geometrical representation of this fea-
ture is a line. Logging this type of feature requires that 
you move along this line.

- Area feature: The geometrical representation of this fea-
ture is an area. Logging this type of feature requires that 
you move along its contour or you make several static 
occupations if it is a regular area (with straight sides).

- Grid feature: The geometrical representation of this fea-
ture is an array of evenly-distributed waypoints. 
MobileMapper will guide you to each of these waypoints 
where you should enter a measurement performed at this 
point.

Each feature also has a number of attributes. There are three 
categories of attributes:
- Menu style where the attribute values are words or 

phrases that you pick off a list (e.g. Condition attribute 
opposite)

- Numeric style where you select a number within a speci-
fied range (e.g. # of Bulbs attribute opposite)

- Text style where you type in a note that can contain both 
numbers and letters (e.g. Closest Street Address attribute 
opposite)

You can input as many as five feature libraries into Mo-
bileMapper. Just remember that you can use only one feature 
library for logging data to an individual job.
A feature library is a
hierarchical structure

that guides you through
the description process

so you know you will
describe thoroughly and
quickly each feature you

visit. You will not have to
remember what

attributes of each feature
you should record: the
feature library will tell

you!

Example of a “stree-
tlight” point feature, as

may be described in a
feature library

Feature libraries are cre-
ated using the Feature

Library Editor module in
MobileMapper Office.

Condition

# of bulbs

Closest

Address

List Attribute
valuesof streetlight 

- Good
- Needs repair
- Needs paint

Enter

Type in

numeric value

Street

address

attributes
9
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Logging New GPS/GIS Data
Prior to starting logging GIS data, be sure MobileMapper is 
computing your position when you stand near the first fea-
ture you want to log.
Press NAV until you display the Map screen. If an arrow is 
displayed at the center of the Map screen and you can see 
that your position on the screen is the expected one, then you 
can start your job. Follow the instructions below to log GIS 
features.
1. Creating a Job and selecting a Feature Library

- Press the LOG button
- Select the Create New Job option and press ENTER. 

The screen displays the Job Name field in which you 
should enter the name of the new job. A keyboard is 
displayed underneath to let you enter this name.
To use the keyboard, press the arrow keys to move 
the cursor over the keyboard. For example, if the job 
name is “JB010”, highlight “J” using the arrow keys 
and press ENTER. Then select “B” and press 
ENTER, etc.

- When you have finished entering the name, highlight 
the OK key on the screen and press ENTER. A new 
screen is then displayed listing the feature libraries 
stored in MobileMapper

- Use the down/up arrow to highlight the library you 
want to work from and press ENTER. The screen 
now lists all the features available from the selected 
feature library.

2. Logging and Describing a Point Feature
- Choose the type of feature you want to log from this 

list. You can tell by the name of this feature whether 
it is a point feature, a line feature or an area feature.

- Highlight a point feature (you are supposed to be near 
one of these features) and press ENTER. This starts 
feature logging.
Entering a job name

The keyboard is fitted
with special keys such as

the CLEAR key to clear
the job name field, the

Shift key to switch
between upper and

lower-case, the back-
space key to delete the
last entered character

and a space key.

Note that a “Generic”
library containing

default features is cre-
ated in MobileMapper at

power on. This library
contains a point feature,

a line feature, an area
feature and a grid fea-

ture. Each of these fea-
tures has a single text-

style attribute. Use this
library only as “backup”

library.

MobileMapper uses a
fixed, time-based log-

ging interval (1 second)
when you log a point fea-
ture. The logging interval

parameter cannot be
accessed when you log a

point feature.
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The Logging screen is now displayed where you can 
see the list of attributes pertaining to this feature. You 
will now enter the “Description” phase of the feature

- With the first attribute highlighted, press ENTER and 
choose the right attribute value describing the feature 
near you and press ENTER. This takes you back to 
the Logging screen.

- Highlight the next attribute in the list and repeat the 
previous step. Repeat this step until all the attributes 
have been properly described.
“Describing” the feature only takes a few seconds. 
By the time you are done with the feature description, 
the feature’s GPS position will probably have been 
saved in the job. You can also stay more time on the 
feature to let the receiver determine several positions. 
This will give an even more accurate position for the 
feature as MobileMapper will average all the GPS 
positions it has computed on the feature.

- To stop logging the feature, on the Logging screen, 
use the down arrow to highlight the Close field and 
press ENTER. This takes you back to the Feature List 
screen

- Move to the next feature and resume the above 
instructions to log this feature.

3. Logging and Describing a Line Feature
Basically, you use the same procedure as when you log a 
point feature (see 2. above). There are however two dif-
ferences when you log a line feature:
- You need to define a logging interval when you start 

logging the feature
- And then you are supposed to move from the begin-

ning to the end of the line feature before stopping the 
logging.

These differences are explained below.
Logging screen

The Logging screen also
displays the time elapsed

since you started log-
ging at this point fea-

ture, the number of
satellites currently

received and the current
value of PDOP (see also

page 22).

If you start logging a new
feature and you realize

you this is a mistake, then
you can delete the new

feature being logged by
pressing MENU and

selecting Delete <fea-
ture name>.

Deleting features only
applies to new features

being logged, not to fea-
tures already logged.
11
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After highlighting a line feature from the Feature List 
screen (for example a road) and pressing ENTER, 
MobileMapper starts logging GPS positions from the 
position where you are. The first time you log a line area, 
and then every time you think this is necessary:
- Press MENU, highlight Logging Interval and press 

ENTER. Two options are then prompted:
By Time: Select this option when you want 
MobileMapper to log a new GPS position at regular 
intervals of time regardless of the distance traveled 
since the last position logged. After highlighting this 
option, press ENTER, choose a time interval from the 
list and press ENTER. This takes you back to the 
Logging screen where you can see the list of 
attributes pertaining to the feature.
By Distance: Select this option when you want 
MobileMapper to log a new GPS position only after 
you have moved by a certain distance since the last 
position logged. After highlighting this option, press 
ENTER, choose a distance interval from the list and 
press ENTER. This takes you back to the Logging 
screen where you can see the list of attributes pertain-
ing to the feature.

- Like with a point feature, describe the feature by 
describing the different attributes pertaining to the 
feature

- When the description is finished, you can start walk-
ing along the line feature

- When you arrive at the end of the line feature, with 
MobileMapper still displaying the Logging screen, 
highlight the Close field at the bottom of the screen 
and press ENTER to stop logging the feature.
Selecting the logging
interval option

Logging screen
The Logging screen also

displays the distance
traveled since you

started logging the line
feature, the number of

satellites currently
received and the current
value of PDOP (see also

page 22).
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4. Logging and Describing an Area Feature
Basically, you use the same procedure as when you log a 
line feature, especially regarding the need for defining a 
logging interval (see 3. above).
What is new when you log an area feature is that you can 
use one of the following two methods:
- The first method should be used when contours of 

areas are irregular. This method is similar to logging 
a line area in that you have to move along the con-
tour, but you also have to come back to the start point 
so that MobileMapper can accurately measure the 
area.

- The second method applies to areas with regular con-
tours, i.e. those with straight sides. With such areas, 
you just have to go to each corner of the area, make 
static occupation there and pause the logging between 
static occupations. MobileMapper will deduce the 
area after you log the last corner and you close the 
feature.

Use the same procedure as on page 11 when you choose 
the first method.
When the shape of the area allows you to use the second 
method, do the following after arriving at one of the cor-
ners and with the Attribute List displayed on your 
MobileMapper:
- Select the name of the area feature from the list of 

features and press ENTER. MobileMapper starts log-
ging the area feature.

- Choose a time-based logging interval (see explana-
tions given for a line area on page 12). This takes you 
back to the Logging screen where the list of attributes 
for the feature is displayed

- Describe each attribute by selecting or entering the 
appropriate attribute value for each of them. (Note 
that you have to do this only once, not on each corner 
of the area.)
Irregular area

Regular area

Logging screen
The Logging screen also

displays the current
value of area measured

since you started log-
ging the feature, the

number of satellites cur-
rently received and the
current value of PDOP

(see also page 22).
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By the time you are done with the description, 
MobileMapper will probably have logged the GPS 
position of the corner.

- Now, press MENU, highlight Pause <feature name> and 
press ENTER. This pauses the logging of the feature.

- Move to the next corner of the area where you can 
now resume logging the feature

- To do this, press MENU, highlight Resume <feature 
name> and press ENTER. This resumes the logging.

- Resume the previous three steps until all the corners 
of the area have been visited.

- After logging the GPS position of the last corner, 
highlight Close at the bottom of the screen and press 
ENTER. This closes the logging of the area feature.

5. Repeating a Feature
If you close a feature and want to log the location of 
another feature of the same type and with an identical 
description, use Mobile Mapper’s Repeat Feature func-
tion.

- After closing a feature, MobileMapper takes you back to 
the Feature List screen. Then do the following:
- Move to the next similar feature you want to log
- Then press MENU, highlight Repeat Feature and press 

ENTER. This starts feature logging. Note that the 
feature has the same attribute description as the 
former one

- After logging the GPS position(s) of this feature, 
highlight the Close field and press ENTER to close 
the feature.
Selecting the Pause
Park option

Selecting the Repeat
Feature option
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6. Nesting a Feature
When you are logging GPS positions to a feature, you 
may find another feature that you also want to log. 
Rather than log the entire feature and come back to 
record this other feature, you can simply pause the fea-
ture being logged, log the other feature, close it and 
resume logging the first feature.
Logging one feature while you have paused another fea-
ture is called “nesting.” You can nest any feature, point 
line or area, into any line or area feature. Its does not 
make sense to nest a feature into a point feature.
Nesting is particularly useful when you are mapping 
things such as a road with streetlamps along the route or 
a shoreline with stretches of erosion along it and the 
locations of certain habitats.
Assuming you are logging a line feature and the Logging 
screen is displayed, do the following, for example to nest 
a point feature:
- Press MENU, highlight Nest Feature and press 

ENTER. This pauses the logging of the line feature.
- Move to the location of the feature you want to nest
- In the Feature List screen now displayed, highlight 

the feature you want to nest and press ENTER
- Describe the attributes of the feature as you would 

normally do
- Highlight Close at the bottom of the screen and press 

ENTER. This closes the nested feature and takes you 
back to the Logging screen of the paused feature

- Press MENU, highlight Resume <feature name> and 
press ENTER. This takes you back to the Logging 
screen from which you can normally finish the log-
ging of this feature.
15

om Www.Somanuals.com. All Manuals Search And Download.



16

Download from
7. Offsetting a Point Feature
Sometimes the feature you want to put on the map is in 
area of poor GPS reception or is not accessible. This is 
when you can map the feature using the offset utility. By 
combining the receiver’s position with the bearing and 
distance to the feature, MobileMapper will automatically 
calculate and record the position of the feature.
To input an offset for a point feature, assuming the Fea-
ture List screen is now displayed, do the following:
- Highlight one of the listed point features available 

from the selected feature library and press ENTER
- Press MENU, highlight Offset and press ENTER. This 

displays the Point Offset screen on which you should 
enter the following parameters:
Bearing: Compass direction to the feature from your 
current position. You need a compass to measure this 
angle (see also opposite). To input a value for Bearing, 
press ENTER and increment or decrement the high-
lighted number using the up/down arrows. To edit 
another digit, use the left/right arrows. When you are 
done, press ENTER again. Press the down arrow to 
move the cursor to the next field.
Horz. Distance: Horizontal distance to the feature from 
your current position. Enter a value for Horz. Distance 
as described above for Bearing. When you are done, 
press ENTER again.
Vert. Distance: Vertical distance to the feature from 
your current position (“0” if the feature and yourself 
are at the same elevation -on a flat area). Enter a 
value for Vert. Distance as described above for Bearing. 
When you are done, press ENTER again.

- Then press ESC to return to the Logging screen. This 
writes the offset into memory, but you can edit it later 
if you like by going through the same process. If you 
close the feature and return to the Map screen, you 
will see that the feature is offset from your position in 
the middle of the screen.
Point Offset screen

If you do not have a com-
pass, you can use

MobileMapper’s Com-
pass screen (see also

page 31) to determine the
bearing to the offset fea-

ture. If you have been
moving for 5 to 10 sec-

onds along a straight
line, the Compass screen

will tell you your bear-
ing. You can use this to

determine the bearing to
the offset feature. CAU-

TION! The receiver can-
not determine direction

while stationary.

Visual estimation for
horz. & vert. distances is

usually good enough in
terms of accuracy.
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8. Offsetting a Line or Area Feature
For the same reasons as a point feature (see previous 
page), you may need to use the offset utility to map a line 
or area feature. By combining the receiver’s position 
with the direction and the distance to the feature, 
MobileMapper will automatically calculate and record 
the location of the feature.
To input an offset for a line or area feature, assuming the 
Feature List screen is now displayed, do the following:
- Highlight one of the features available from the open 

feature library and press ENTER.
- Press MENU, highlight Offset and press ENTER. This 

displays the Line or Area Offset screen on which you 
should enter the following parameters:
Direction: Location of the feature with respect to your 
actual path. To input a value for Direction, press 
ENTER, choose one of the two options (Right or 
Left) and press ENTER again. Press the down arrow 
to move the cursor to the next field.
Horz. Distance: Horizontal distance to the feature from 
your current position. To input a value for Horz. Dis-
tance, press ENTER and increment or decrement the 
highlighted number using the up/down arrows. To 
edit another digit, use the left/right arrows. When you 
are done, press ENTER again. Press the down arrow 
to move the cursor to the next field.
Vert. Distance: Vertical distance to the feature from 
your current position (“0” if the feature and yourself 
are at the same elevation -on a flat area). Enter a 
value for Vert. Distance as described above for Horz. Dis-
tance. When you are done, press ENTER again.

- Then press ESC to return to the Logging screen. This 
writes the offset into memory, but you can edit it later 
if you like by going through the same process. If you 
close the feature and return to the Map screen, you 
will see that the feature is offset from your position in 
the middle of the screen.
Line or Area Offset
screen

Visual estimation for
horz. & vert. distances is

usually good enough in
terms of accuracy.

On the left On the right

Line Area
17
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9. Logging GIS Data on a Preset Grid Network
MobileMapper's grid mapping utility is an easy way to 
automatically set up a series of GPS waypoints to facili-
tate the logging of data in an orthogonal grid. This utility 
assures that you gather measurements made using field 
sensors such as chemical detectors, depth sounders and 
magnetometers at an evenly distributed set of locations. 
This in turn assures the creation in your GIS of contour 
maps with a prescribed density of data and without any 
gaps that might force you to return to the field.
To log GIS data on a preset grid, do the following:
- Navigate to the waypoint of the grid where you 

want to begin logging data: If you have created a 
waypoint to help you locate the first grid point, you 
can use any of MobileMapper's navigation screens to 
get there. To access a waypoint file you can use to 
navigate to the point of beginning, press the MENU 
button and select the GOTO option. Then select the 
User option. This will place the waypoint symbol and 
label on the base map displayed on the receiver's Map 
screen. Again, you may use any of MobileMapper's 
navigation screens to arrive at this waypoint.

- Display the grid: Once you arrive at the point of 
beginning, you should open up the job file that 
includes the feature library describing the grid. If you 
opened an existing job, press LOG to take you to the 
New Feature screen. Then select the grid feature type 
listed on the screen. Usually the term “grid” is 
included somewhere in the feature name so that you 
can easily recognize this type of feature. After select-
ing the grid feature, the Grid Setup screen appears on 
which you can read the definition of the grid (spac-
ing, columns, rows and heading).
To operate the grid map-
ping utility, you will need

a measurement device -
anything from a depth

sounder to a ruler, your
own sense of smell or

your ability to make
visual observations. You

will also need a compass.

How a grid is defined in
MobileMapper

Heading

North

Column
Row

Spacing
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- Record an observation or measurement: With the 
OK field highlighted, just press ENTER. This takes 
you to the Logging screen that indicates that you 
have begun logging data to the feature and that the 
receiver is ready to log the feature's attributes. 
Remember that you remain stationary for all point 
features. Describe the feature as you would any other 
point feature.

- Navigate to the next grid point: When you have fin-
ished recording the first point feature, you can select 
Next Pt at the bottom left to navigate to the next grid 
waypoint and record the next point feature within the 
grid. This takes you to the Map screen where you can 
see your current position marked by the arrow and 
the next grid waypoint highlighted with a “crossed 
box” target symbol. Small red circles indicate the 
locations of all the unvisited grid waypoints. The 
locations of where you recorded point feature are 
indicated by small black squares.
As you begin moving toward the target symbol, you 
will see your heading indicated by the direction of the 
arrow marking your position. Adjust your movement 
as necessary until you are positioned over the target 
symbol. You may also use any of the other navigation 
screens available with MobileMapper. The Arrival 
alarm is disabled when navigating to grid waypoints. 
It is best to note your distance to the next waypoint 
and stop when this value goes to zero. When you 
arrive at the next grid point, press the LOG button 
and you will see the same Logging screen you used 
for the earlier measurement or observation.
It is also possible to navi-
gate to any grid waypoint

(or any location for that
matter) on the Map

screen by moving the
arrow key over another

grid waypoint and press-
ing ENTER. After you

record data at this loca-
tion, the Next Pt field may

still be selected to go to
the next grid waypoint in

the network.
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Each grid waypoint is a geographic coordinate you 
should make every effort to occupy so that the data 
you record is evenly spaced and complete. However, 
each grid waypoint is merely an aid for navigating to 
the ideal location for an observation or measurement. 
All the data you record is ascribed to the position of 
the MobileMapper receiver and NOT to the grid way-
point. If you cannot physically occupy this waypoint, 
but can make the necessary visual observation, you 
should do so and record an offset estimating the dis-
tance and bearing to the grid waypoint. If you are 
recording measurements made by an instrument, you 
should NOT record an offset but rather try to make a 
recording as close as possible to the position.

- When you have occupied as many of the grid way-
points as you can and recorded the necessary obser-
vations and measurements at each, highlight the Close 
field at the bottom of the Logging screen and press 
ENTER. This closes the grid feature and returns you 
to the New Feature selection screen where you may 
either log data to another feature, even to another 
grid, or close the entire job.

10.Changing the Parameters of a Grid Network Before 
Logging GIS Data
When you navigate to the location of the grid, you may 
decide to readjust the size and orientation of the grid 
based on field observations that you did not foresee back 
in the office. For example, you may find that navigating 
to waypoints with an east-west orientation is not feasible 
if the area of interest is situated on a narrow strip of land 
between two north-south running streams.
When you change the definition of a grid, MobileMapper 
always assumes that you are standing in the corner of the 
grid from which you can see the grid extend in front of 
you and to the right.
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In the open job, do the following:
- On the Feature List screen, select the grid feature and 

press ENTER. On the Grid Setup screen that is now 
displayed, set the parameters listed below.
Spacing: Distance between any two consecutive way-
points in any row or column (default: 50 meters or 
100 feet, depending on the units used)
Columns: Number of waypoints along the axis facing 
you (default: 10; Max.: 100)
Rows: Number of waypoints along the axis perpendic-
ular to the direction you are facing (default: 10; Max.: 
100)
Heading: Direction you face when the grid’s columns 
extend in front of you and the rows extend to your 
right.
To change the above parameters, use the up/down 
arrows to move the cursor to each of these fields, 
press ENTER, use the up/down arrows to increment/
decrement the highlighted figure, use the right/left 
arrows to highlight the next/previous digit in the 
field. When you are done with the definition of a 
field, press ENTER. Then press the down/up arrow to 
access the next field, etc.
Once these parameters have been changed, highlight 
OK at the bottom of the screen and press ENTER

- This takes you to the Logging screen from which you 
an start logging data as explained previously.

11.Closing a Job
To close a job, all you have to do is open up another job 
or turn the receiver off. To open another job, use the Open 
Job option after pressing the MENU button.
Grid Setup screen

In the two examples
above:

Columns=8
Rows=6

Heading=21°

North

(Heading= 0°)

Co
lum

n

Row

North

Column
Row

Sp
ac

ing

Spacing
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GPS Accuracy
MobileMapper provides better than 10-m autonomous accu-
racy around the globe assuming the receiver is tracking five 
GPS satellites and the PDOP < 4 (which is almost all the 
time).
If you average positions for a point feature for a few minutes, 
even better accuracy is possible.
MobileMapper will warn you if your accuracy of your posi-
tions has cropped below the level you selected during Setup 
(see page 54, Alarms option). If you see this warning you may 
press the ESC button and continue logging. However, if you 
are recording line or area features, you might want to return 
to the field when the GPS satellites are in a better configura-
tion overhead (the constellation changes slowly but con-
stantly). And if you are recording a point feature, you should 
strongly consider moving to another location with better sat-
ellite reception and recording an offset (distance and bear-
ing) to the feature.

GPS Quality Indicators
On each logging screen as well as on the Satellite Status 
screen, you can see at the bottom two numbers that give you 
a good indication of how accurate your positions should be.
The first is the number of satellites that the receiver is track-
ing.
The second number is the Positional Dilution of Precision, 
which is an estimate of accuracy that the receiver constantly 
calculates using the geometry of satellites in the sky. The 
more satellites that are being tracked and the more evenly 
they are distributed around the sky, the better the accuracy. 
PDOP values less than 4 or 5 are good. If the PDOP value is 
over 10, you should consider moving to an area with a clear-
er view of the sky and recording features with offsets.
MobileMapper is also
capable of providing 3-m

horizontal accuracy
using real-time differen-
tial corrections from its
built-in WAAS/EGNOS

receiver. You must be in
North American to make
use of the free WAAS sig-
nal broadcast by the US

Federal Aviation Admin-
istration. You must be in

Europe to make use of
the free EGNOS signal
broadcast by the Euro-
pean Union. If you are

receiving a WAAS or
EGNOS signal, a “W”
appears on the screen.

GPS quality indicators

Tracking 3 satellites will
allow you to calculate a

2D position (lat/lon)
using the last altitude

recorded by the receiver.
You need to track at least

4 satellites to get a 3D
position (lat/lon/altitude)
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Revisiting and Updating Existing GPS/GIS Jobs
You can use MobileMapper not only to position and de-
scribe new GIS features but also to update information gath-
ered previously. This is particularly useful when collecting 
data on things that change over time: streetlight bulbs burn 
out, new roads are added to housing developments, new 
crops are planted, etc.

1. General Procedure
After you have arrived in the area of the job to be reviewed, 
after you have turned on MobileMapper and made sure it 
calculates your position, follow the procedure below to re-
visit and update this job.
- Press the LOG button, select the Open Existing Job option 

and press ENTER. MobileMapper lists all the jobs 
present in its memory.

- Press the down arrow to highlight the name of the job 
you want to update and press ENTER. MobileMapper 
displays the navigation screen that was last used.

- Unless this screen is already displayed, press NAV 
repeatedly until the Map screen is displayed. From this 
screen, you will now indicate the first feature you want 
to revisit. If necessary, press the IN or OUT button to 
adjust the scale so you can see this feature.

- Press any arrow key to switch to the cursor mode on the 
Map screen and then use the arrow keys to move the cur-
sor over the feature you want to revisit first. It’s a good 
idea to keep the Map info visible on the screen as it tells 
you exactly when the feature is selected. (The feature 
name appears in the lower part of the screen when the 
cursor is positioned over the feature.)

- When this happens, press ENTER. The Selected screen 
is now displayed showing the attribute values currently 
ascribed to the feature. Note that the Goto field is high-
lighted at the bottom of the screen.
Job List screen

Note that you are not
prompted to select a fea-

ture library when you
select an existing job.

This is because the
library that was selected

when the job was created
is necessarily the one

that must be used for the
job when re-opening this

job

Selected screen
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- Press ENTER to ask MobileMapper to guide you to this 
feature. If you simply press ENTER, you will make the 
selected feature your destination and all the navigation 
screens will be set to help you reach that feature. Press 
NAV to access any of these screens. On the Map screen, 
you can now see a straight line connecting your current 
destination to the selected feature.

-  Walk to the feature according to the navigation instruc-
tions provided on the Map screen. You can use other nav-
igation screens if you prefer (see also Navigation Screens 
chapter from page 26). You will know when you are 
close to the feature when the distance to the feature goes 
to zero or close to zero, or simply because you can iden-
tify it visually. Another nice way of being informed that 
you have arrived at the feature is to set the Alarms option 
(see explanations on page 54)

- After arriving at the feature, press the LOG button. This 
takes you back to the Selected screen.

- Now that you are near the feature, highlight the Edit field 
and press ENTER. You are now allowed to edit each of 
the feature’s attributes.

- After reviewing the attributes that need to be changed, 
highlight the Close field at the bottom of the screen and 
press ENTER. This ends the review of this feature and 
displays the Map screen again.

- Follow the same 7 steps described above to revisit and 
update the other features present in the job.
Map screen showing
straight line to target
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2. Repositioning a Point Feature
If a point feature appears to be mislocated on the Map screen 
or if you wish to make the position more accurate (by using 
an external antenna, occupying point positions for more 
time, etc.), do the following once you have arrived at the fea-
ture and the Selected screen showing all the feature’s at-
tributes is displayed:
- Press MENU, select the Update Position option and press 

ENTER.
If you press NAV and go back to the Map screen, you 
will now see two features (one at the old position, the 
other at the new position). To remove the feature's old 
position, just move the map cursor so that the feature is 
off the screen. When you move the cursor back to the 
feature, only the new position will be visible.

3. Adding More Features and Attributes to the Job
If you want to add more features and descriptions to the ex-
isting job, you just have to record them exactly as you record 
features into a new job.

4. Closing the Job
To close the job, all you have to do is open up another job or 
turn the receiver off. To open another job, use the Open Job 
option after pressing the MENU button. You cannot acciden-
tally lose data with MobileMapper without opening the re-
ceiver and losing or damaging the internal memory card.
The Repositioning func-
tion only applies to point

features, not to line or
area features.

Selecting
Update Position
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Navigation Screens
MobileMapper 
offers 7 differ-
ent navigation 
screens to help 
you locate 
yourself or 
navigate to 
waypoints or 
point features 
in an existing 
job. From any 
displayed screen, simply press the NAV button to access 
navigation screens. To display the next navigation screen, 
press NAV again. The sequence of navigation screens is as 
shown above. It can be scrolled in the reverse direction by 
pressing ESC once any of these navigation screens is dis-
played.
Each type of navigation screen is presented hereafter.

Map Screen
The Map screen shows a map of the area surrounding your 
current location. Use the IN and OUT buttons to adjust the 
scale.
The Map screen is always in the Position mode when you ac-
cess this screen. In this mode, your present position is indi-
cated by the large arrow icon in the center of the display. If 
you are moving, the arrow will point in the direction that you 
are heading. At the bottom of the screen is the scale for the 
map displayed and two data fields that can be customized, or 
turned off, depending upon your needs.
The present position icon will change to an hourglass when 
the MobileMapper is unable to compute a position fix due to 
poor signal reception.

Press NAV

Position Screen 2

Large Data Screen

Compass Screen

Map Screen

Satellite Status Screen

Speedometer Screen

Data Screen

Road Screen

Position Screen 1

Press NAV

etc.
The Map screen has two
modes: Position and

Cursor. Use any arrow
key to select Cursor

mode, ESC to return to
Position mode

When a Position screen
is displayed, press the

Left or Right arrow key
to display the other.

Press this key again to
return to the previous

screen.

Except for the Satellite
Status screen, all naviga-

tion screens can be cus-
tomized.

Map screen
in Position mode
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The dotted line on the map displays the history of where you 
have traveled since the last time you cleared the track histo-
ry.
Press any of the arrow keys to switch to the Cursor mode. In 
this mode, you are provided with a cross hair cursor that can 
be moved on the map with the arrow keys. At the bottom of 
the display is the information for the position of the cursor 
relative to your present position (heading and distance). Also 
any points of interest or GIS features that the cursor is over 
will be shown.
To return to the Position mode, press ESC. The cursor will 
disappear and the present position icon will appear centered 
on the map.
To set and/or customize the Map screen, use the functions 
described below. These context-sensitive functions are ac-
cessed by pressing the MENU button while the Map screen 
is displayed.

Show/Hide Map Info
Use this option to show or hide the two data fields displayed 
at the bottom of the Map screen. To customize these fields, 
see Select Map Info below.
Map screen in
cursor mode
27
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Select Map Info
Use this option to tell MobileMapper which data should be 
displayed at the bottom of the Map screen. This can be:
- Customize Fields. This function is equivalent to the Custom-

ize function available from all navigation screens other 
than the Map screen. See page 38.

- Street info: This option displays an information block at 
the bottom of the display showing the name of the street 
your present position or cursor is on. If in the cursor 
mode, the bearing and distance from your present posi-
tion are displayed.

Map Setup
You can make the following settings using the Map Setup op-
tion. To access this option, press MENU when the Map 
screen is displayed, select Setup and then select Map Setup. 
The screen that appears contains two tabs: the Format and Dis-
play tabs.
On the Format tab, you can set the following parameters: 
- Orientation: You can change how the map is orientated on 

the screen to either North Up, Course Up or Track Up. 
Default is North Up.

- Detail: Use this field to set the map detail. The detail of 
the map can be set to highest, high, medium, low or low-
est. This changes the zoom level that different map 
objects (cities, highways, labels, etc.) are displayed. If 
you have set a zoom level and the display is too clut-
tered, set the map detail to a lower level; conversely set it 
to a higher level to view more detail.
The Map screen must be
in Position mode if you
wish to customize data

fields. If the Map screen
is in cursor mode (cursor

is a cross-hair), press
ESC to return to the

Position mode

Map Setup screen,
Format tab
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- Track Mode: Allows you to set how often MobileMapper 
stores track points. Setting the mode to Off stops the unit 
from saving any new track points. With Auto or Auto 
Detailed enabled, MobileMapper uses a method for track 
point storage that maximizes memory. Using Auto, you 
will see more points on and near turns and less points on 
straight stretches of the map. You also have the option of 
selecting fixed intervals for track point storage.

- Primary Usage: MobileMapper can be set to either Land or 
Marine usage. When in Land (default), the map displays 
land areas in white and water areas in blue. For marine 
applications it may be desirable to reverse the display, 
showing water as white and land as blue. This will make 
reading some of the data information on the water easier.

From the Display tab, you can customize the Map screen by 
specifying the items that MobileMapper should display on 
the map:
- Waypoints (default: checked)
- Track Lines (a dashed line; Default: Checked)
- Pos-Dest Line (line connecting current position to destina-

tion)
- Depart-Dest Line (line connecting initial position to desti-

nation)
29
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Check the items you want to show and clear those you want 
to hide. You can also check or clear all these items in a single 
operation by respectively selecting Mark All or Clear All just 
above these items and then pressing ENTER

Goto Cursor
If the Map screen is in cursor mode, the first option available 
from the list displayed after pressing the MENU button is 
Goto Cursor. Select this function when you want MobileMap-
per to guide you to the location where the cursor currently is 
on the Map screen. Starting from your current location, Mo-
bileMapper will indicate the distance to go and the heading 
to the cursor location.
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Compass Screen
The two data fields on top are customizable. The lower por-
tion of the Compass screen not only displays your heading in 
a graphical manner, but also displays the relationship of the 
sun, moon and your destination (if navigating on a route) to 
your heading.
The Compass screen contains the following information, 
from top to bottom:
- In the title bar: destination name if you are using the 

Goto function
- Data Fields: customizable data fields (see Customize 

option below). Some of the data displayed requires you 
to be moving to be computed. Invalid data is indicated by 
dashes.

- Icon representing destination: Displayed outside the 
compass when you are using the Goto function. This pro-
vides you with the direction you need to head to arrive at 
the destination. When you are on course and heading 
straight for the destination, the destination icon will be 
lined up with the heading marker

- Compass/Heading marker: Using the compass and the 
heading marker, you can view your heading information 
in a familiar manner. Note that you need to be moving 
for this data to be valid.

To customize the Compass screen, use the function de-
scribed below. This context-sensitive function is prompted 
when you press the MENU button while the Compass screen 
is displayed.

Customize
See page 38.
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Large Data Screen
The Large Data screen is similar to the Compass screen but 
here the compass has been removed to allow for large dis-
play of the navigation data. This screen is ideal for when you 
have your unit mounted on the dashboard of a vehicle. Even 
from a distance the customizable information can be read 
with ease.
The Large Data screen contains the following information, 
from top to bottom:
- In the title bar: destination name if you are using the 

Goto function
- Data Fields: customizable data fields (see Customize 

option below). Some of the data displayed requires you 
to be moving to be computed. Invalid data is indicated by 
dashes.

To customize the Large Data screen, use the function de-
scribed below. This context-sensitive function is prompted 
when you press the MENU button while the Large Data 
screen is displayed.

Customize
See page 38.
Large Data Screen
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Position Screens 1 & 2
To switch from a screen

to the other, just press the
Left or Right arrow key

The same data as on
Position screen 1 is dis-

played on Position
screen 2 except that the

lower part of the screen,
containing the two data

fields and the trip odom-
eter field, is replaced
with the current posi-

tion’s coordinates
expressed in the chosen

secondary coordinate
system and map datum.
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Position Screens
Position screens #1 and #2 display your present position us-
ing the coordinate systems that you have selected. This 
screen shows all of the basic position, time and satellite in-
formation. Additionally, on Position screen #1, current nav-
igation information is shown in the bottom half of the screen.
For the sake of comparison, Position screen #2 provides the 
coordinates of your present position both in the selected pri-
mary coordinate system and map datum, and in the selected 
secondary coordinate system and map datum.
Position screen #1 contains the following information, from 
top to bottom:
- Coordinates and elevation of your current position: Dis-

plays your current position in the chosen coordinate sys-
tem. Also displays the elevation of the current position. 
If MobileMapper is not computing position fixes, the last 
computed position is displayed.

- GPS Status: Provides information on the current status of 
the GPS receiver portion of the MobileMapper (see table 
below).

Message Description

Searching - 1st sat Searching for 1st satellite

Searching - 2nd sat 1st satellite found; searching for 2nd satellite

Searching - 3rd sat 2 satellites are being tracked; searching for a 3rd

Searching - 4th sat 3 satellites are being tracked; searching for a 4th

Collecting Data All satellites needed for position fix are being 
tracked and position is being computed

Averaging MobileMapper is computing fixes; speed is near 
0.0 and so position is being averaged

EPE xxx. Estimated Position Error. MobileMapper is comput-
ing fixes while moving

DGPS Computed fixes are being differentially corrected
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- Data Fields: customizable data fields (see Customize 
option below). Some of the data displayed requires you 
to be moving to be computed. Invalid data is indicated by 
dashes.

- Trip Odometer: The odometer performs like the odome-
ter in your car. It can be reset through the MENU button.

To customize the Position screens, use the functions de-
scribed below. The first of these context-sensitive functions 
is prompted when you press the MENU button while a Posi-
tion screen is displayed. Some of these functions also exist 
in the Setup menu.

Coord System, Map Datum and Elev Mode
See page 51 and page 52

Reset Trip (from Position screen 1 only)
If you select this option and you press ENTER, a warning 
message is displayed asking you to confirm your choice. To 
reset the trip odometer, highlight the Yes field and press EN-
TER.

Customize (from Position screen 1 only)
See page 38.
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Road Screen
The Road screen presents your route as if you were travel-
ling on a road. When you need to make a turn, the road will 
graphically display the turn and the direction. Waypoint and 
destination icons will be displayed relative to your position 
as they come into view. Above the road is a compass that dis-
plays your heading and above that are four customizable 
data fields.
The Road screen contains the following information, from 
top to bottom:
- In the title bar: destination name if you are using the 

Goto function
- Data Fields: customizable data fields (see Customize 

option below). Some of the data displayed requires you 
to be moving to be computed. Invalid data is indicated by 
dashes.

- Compass: Displays your heading in a familiar compass 
format.

- Road: This graphically displays the route (Goto) that is 
active. As you move left or right of your intended track, 
the road will move on the display indicating which way 
you need to steer to get back on track. Ideally, the road 
would be centered on the display. Also, you will see 
upcoming turns in advance allowing you to make neces-
sary preparations.

- Scale indicator: Use Zoom In/Out to change the scale.
To customize the Road screen, use the function described be-
low. This context-sensitive function is prompted when you 
press the MENU button while the Road screen is displayed.

Customize
See page 38.
Road Screen
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Data Screen
When you need to see a lot of information in one place then 
you will appreciate the Data screen. The Data screen pro-
vides you with six data fields and an active compass that is 
the same as the one used on the road screen. You have the op-
tion of customizing this screen by selecting what data is dis-
played in the upper six fields. The lower portion of the 
screen is occupied by a compass providing your heading.
The Data screen contains the following information, from 
top to bottom:
- In the title bar: destination name if you are using the 

Goto function
- Data Fields: customizable data fields (see Customize 

option below). Some of the data displayed requires you 
to be moving to be computed. Invalid data is indicated by 
dashes.

- Compass: Displays your heading in a familiar compass 
format.

To customize the Data screen, use the function described be-
low. This context-sensitive function is prompted when you 
press the MENU button while the Data screen is displayed.

Customize
See page 38.
Data Screen
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Speedometer Screen
The Speedometer screen displays your speed in a familiar 
graphical format. There are four additional data fields at the 
top of the display that can be customized to display the data 
that you need. The bottom of the screen contains a trip 
odometer that will record the distance travelled since the last 
time the odometer was reset.
The Speedometer screen contains the following information, 
from top to bottom:
- In the title bar: destination name if you are using the 

Goto function
- Data Fields: customizable data fields (see Customize 

option below). Some of the data displayed requires you 
to be moving to be computed. Invalid data is indicated by 
dashes.

- Speedometer: Displays your speed using a familiar 
speedometer display. The scale of the speedometer is not 
adjustable but will change dynamically to best display 
your speed.

- Trip Odometer: The odometer performs like the odome-
ter in your car. It can be reset through the MENU button.

To customize the Speedometer screen or reset the trip odom-
eter, use the functions described below. The first of these 
context-sensitive functions is prompted when you press the 
MENU button while the Speedometer screen is displayed.

Reset Trip
If you select this option and you press ENTER, a warning 
message is displayed asking you to confirm your choice. To 
reset the trip odometer, highlight the Yes field and press EN-
TER.

Customize
See page 38.
Speedometer Screen
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Satellite Status Screen
Although the Satellite Status screen is part of the navigation 
screen sequence, it is not actually a navigation screen. For 
more details on this screen, refer to page 8.
When MobileMapper is computing your position, an addi-
tional information appears in the right-upper corner with two 
possible values: 3D or 2D. 3D means the computed position 
is 3-dimensional (elevation computed). In 2D (2-dimension-
al), elevation is not computed. Mobile Mapper assumes that 
the last computed or entered elevation is the elevation for all 
computed positions.

Customizing Data Fields on Navigation Screens
Except for the Satellite Status screen, all navigation screens 
can be customized through the following procedure:
• Press NAV repeatedly until the desired navigation screen 

is displayed
• Press MENU
• Highlight Customize and press ENTER. For the Map 

screen, first highlight Select Map Info and press ENTER. 
Then highlight Customize Fields and press ENTER.

• On the Navigation screen now shown in edit mode, high-
light the data field to be changed using the left/right 
arrow and press ENTER

• Choose the data in the list that you wish now to display 
in this field. Press ENTER. Data change in the field is 
immediate.

• Resume this procedure for all the fields that need to be 
changed on this screen and on the other navigation 
screens.
Satellite Status Screen

Available data:
BEARING

DISTANCE
SPEED

HEADING
VMG (Velocity made

good)
CTS (Course to steer)

ETA (Estimated time of
arrival)

ETE (Estimated time
enroute

XTE (Crosstrack error)
TURN

Elevation
TIME
DATE

EPE (Estimated Posi-
tional Error)

AVG. SPEED (Average
speed)

MAX. SPEED
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GOTO Function
Purpose
You will use the Goto function to ask MobileMapper to 
guide you from your current position to a destination point.
After you will have specified which destination point to go 
to, you will select your favorite navigation screen. You will 
then be able to read the information computed by Mo-
bileMapper to help you reach the destination.

Destination Point Types
Not only can MobileMapper guide you to previously logged 
GIS features but also to other pre-loaded or created points. 
In fact, the destination point can be any of the following:
- Any feature logged in the open GIS job which you will 

select graphically on the Map screen
- Any waypoint created earlier using the MARK function. 

This type of point is stored as a “User” Point of Interest 
(POI)

- Any point of interest (POI) pre-loaded in MobileMapper.

Selecting a GIS Feature as the Destination Point
Press NAV until the Map screen is displayed. Press the arrow 
button in any direction to make the selection cursor appear 
and to position it over the feature you want to go to. You 
know that the cursor is positioned over the feature when the 
“Cursor” indication at the bottom of the screen is replaced 
with the name of that feature.
Press ENTER. A new screen appears giving the current de-
scription of the feature. At the bottom of the screen, the Goto 
field is highlighted: simply press ENTER again to enable the 
Goto function with this feature as your destination. Then se-
lect your favorite navigation screen, using the NAV button, 
and navigate to this feature.
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Selecting a POI as the Destination Point
Press MENU, scroll to the GOTO option and press ENTER. 
The possible categories of POIs are now listed on the screen. 
Select the category the destination point belongs to.
Before pressing ENTER to list all the points stored in this 
category, choose how you want these points to be listed by 
setting the Find By field. Press the left/right arrow to set this 
field. Two values are possible in this field: 
- Alphabetical: Points will be listed in alphabetical order. 

MobileMapper will then help you find the desired point 
through one of the following two methods: Keyboard 
Search and Alphabetic Scroll.
Keyboard Search: Before displaying the list of points in 
alphabetical order, MobileMapper displays a keyboard 
that you can use to enter the first few characters of the 
point you are looking for. When you highlight OK and 
press ENTER, (or as a shortcut, press IN), you are taken 
to the alphabetical list with the point you began typing at 
the top of the display. Anytime you are viewing the list 
of points, you can re-access the keyboard by pressing 
ESC.
Alphabetic Scroll: You can use the IN and OUT buttons 
to step up or down the alphabet. If you were viewing 
points beginning with the letter “A”, pressing OUT 
would take you to the first waypoint beginning with “B”, 
and then “C” and so forth. Pressing IN does the same 
function but only in reverse.

- Nearest To: Only the 20 points from this category the clos-
est to your position will be listed.
When these 20 points are listed, MobileMapper indicates 
the bearing and distance to your current position from the 
first point in the list. You can change the point from 
which the nearest points are found. With the Nearest To 
field now highlighted, press ENTER and scroll to the 
category where this new point can be found. Select a new 
point and press ENTER.
NOTE: If you have
already pressed the

arrow keys and one of the
nearest points in the list

is highlighted, use the
ESC button to scroll back

to the Nearest To field
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Mark screen

The Mark option from
the Menu list provides a

function similar to the
LOG button when held

down for 2 to 3 seconds
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Saving Your Current Position as a Waypoint
Saving your current position as a waypoint is very easy and 
can be done regardless of whether a GIS job is open or not.
From any navigation screen, just hold down the LOG button 
for 2 to 3 seconds until the Mark screen is displayed. This 
screen provides the description of the waypoint you are 
about to save.
You can accept all the defaults by simply pressing ENTER 
(Save field already highlighted).
You can also edit the Icon, Name and Message fields using the 
arrow keys to access these fields. Obviously you should keep 
the Location and Elevation fields unchanged as they contain 
the coordinates of your current location.

Creating a Waypoint With the Map Cursor
This is another way of creating a waypoint whose coordi-
nates will be based on the location of the cursor on the Map 
screen.
Press NAV until the Map screen is displayed. Press any ar-
row key to make the cursor visible on the map. Move the cur-
sor to the desired location on the map using any arrow keys. 
Hold down the LOG button for 2 to 3 seconds until the Mark 
screen is displayed.
You can accept all the defaults by simply pressing ENTER 
(Save field already highlighted).
You can also edit the Icon, Name and Message fields using the 
arrow keys to access these fields. Obviously you should keep 
the Location and Elevation fields unchanged as they contain 
the coordinates of the cursor location.
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Editing/Deleting a User Waypoint
You can edit/delete a waypoint from the Map screen:
- Press NAV until the Map screen is displayed
- Use the IN or OUT button, or move the cursor so that the 

waypoint you want to edit or delete is visible on the 
screen

- Position the cursor over that waypoint. The name of the 
waypoint then appears at the bottom of the screen.

- Press ENTER. This opens the Select Item screen on 
which MobileMapper lists the names of waypoints and 
POIs present in the vicinity. Highlight the waypoint you 
want to edit/delete.

- Press ENTER again. This opens the User Waypoint 
screen on which you can see the definition of the way-
point (coordinates+comments). At the bottom of the 
screen are three command fields that you can use for the 
following tasks:
Edit (default choice): Select this field if you want to edit 
the definition of the waypoint. The following parameters 
can be changed: icon, name, coordinates, elevation and 
comment.
Goto: Select this field if you want MobileMapper to guide 
you to this waypoint
Del: Select this field if you want to delete the waypoint. 
MobileMapper will then ask you to confirm that you 
really want to delete the selected waypoint.
Select Item screen

User Waypoint screen
 Www.Somanuals.com. All Manuals Search And Download.



A GOTO route is a one-
leg route whose two ends
are your current position

and the chosen destina-
tion point.

WPT1

WPT2
WPT3

WPT4

WPT5

WPT6
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Routes
As explained below, MobileMapper can handle two types of 
routes: GOTO route and multi-leg route.

GOTO Route
This in fact a route that you define when:
- You select a feature on the Map screen, you press 

ENTER to display the attributes of this feature, and you 
press ENTER again to enable the Goto function to this 
feature (by default, the Goto field at the bottom of the 
screen is highlighted). The same can be done to choose a 
POI or a waypoint as the destination point.

- You use the GOTO option from the Menu screen and you 
choose a POI or waypoint as the destination point.

GOTO routes are not saved in memory. When you turn your 
MobileMapper off and then back on, the GOTO route is 
gone. You need to create a new GOTO route if you intend on 
completing the route.

Multi-leg Route
A multi-leg route consists of several waypoints or POIs that 
you should reach one after the other. The segment between 
any two consecutive waypoints or POIs is called a “leg.” Un-
like GOTO routes, multi-leg routes can be stored in memory.

1. Creating a Multi-leg Route
Press NAV to display a navigation screen, press MENU, 
scroll down to Routes and press ENTER.
The Route List screen is now displayed. Scroll down the list 
and highlight the first Empty route in the list. Press ENTER.
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The Create Route screen is now displayed. Note that the first 
line on this screen is highlighted.
Press ENTER. The Add WPT screen is now displayed. Se-
lect the category of points containing the first waypoint of 
the route and press ENTER. Choose a point from the list and 
press ENTER. The first waypoint in the route is now defined 
and you are now prompted to define the second one. Resume 
the instructions in this paragraph for the second point, then 
for the third, etc.
When the last point of the route is defined, highlight the Save 
Route field on the Create Route screen and then press EN-
TER to save the route.

2. Creating a Multi-leg Route from the Track History
Press NAV to display a navigation screen, press MENU, 
scroll down to Routes and press ENTER.
Regardless of which route is highlighted in the route list, 
press MENU again and highlight the Save Trk to Rte option. 
Press ENTER. MobileMapper then takes you back to the 
Route List screen on which you can see that the track history 
has been saved as the last route in the list. This route uses a 
naming convention of “T01P01 to T01Pxx” where Pxx indi-
cates the number of points in the route.

3. Activating/deactivating a Multi-Leg Route
Press NAV to display a navigation screen, press MENU, 
scroll down to Routes and press ENTER.
In the Route List screen now displayed, scroll down the list 
and highlight the route you want to activate. Press MENU, 
highlight the Activate Route option and press ENTER. Mo-
bileMapper comes back to the Route List screen where the 
activated route now appears in bold characters. Press NAV to 
navigate along this route.
To deactivate this route, press MENU, highlight Routes, 
press ENTER, highlight the activated route (shown in bold 
characters), press MENU, highlight Deactivate Route and 
press ENTER. The route is now deactivated.
Create Route screen

Route List screen
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4. Other Functions Tied to Routes
You can also do the following on the highlighted route using 
the functions available from the MENU button (see also di-
agram on page 49):
- Viewing the route on the Map screen by highlighting the 

Map View Route option and pressing ENTER. The Map 
screen then appears showing the route. Press ESC to 
come back to the Route List screen.

- Editing the route by highlighting the View/Edit Route 
option and pressing ENTER. From the View/Edit screen 
you can then press the MENU button to access options 
allowing you to insert, delete, replace the highlighted 
waypoint and then to save the changes made to the route.

- Reversing the route, i.e. reversing the direction of travel 
along the route, by highlighting the Reverse Route option 
and pressing ENTER. This instantly reverses the route. 
Note that the first and last waypoints in the route name 
have been swapped.

- Deleting the route by highlighting the Delete Route option 
and pressing ENTER. A message will appear asking you 
to confirm this operation.

- If a route has been activated, selecting the leg you want 
to follow by selecting the Select Leg option and pressing 
ENTER. The screen then shows the list of points making 
up the route. Select the point you want to navigate to and 
press ENTER. A warning message will appear asking 
you to confirm the leg change. After choosing Yes or No, 
press ESC twice to return to the navigation screen.
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MENU button
The list of functions that you can have access to by pressing 
the MENU button depends on which navigation screen is 
displayed and whether GIS data logging is in progress or not. 
The context-sensitive functions are always listed first in the 
menu list (after the ever present Open Job / New Job or Close 
Job options). The other functions, which are always avail-
able as long as the MENU key is active, are always last in the 
list. On the menu screen, a horizontal line separates context-
sensitive functions from the other ones.
The diagram below shows the available functions when 
pressing MENU while navigation screens are displayed and 
no GIS data logging is in progress. These functions are listed 
in the same order as on the screen. Context-sensitive func-
tions appear in the upper frames. Lines connect the context-
sensitive functions to the permanent functions so you can see 
what the entire menu is made of in each context.

Mark
GOTO
Routes
Setup
Delete Files
About...

Customize

From Compass, 
Large Data, 
Road, Data 
screens Coord System

Map Datum
Elev Mode
Projection
(Reset Trip)
(Customize)

From Position screens

Reset Trip
Customize

From Speed-
ometer screen

From Satellite 
Status screen

 (Hide) Map Info

ap 
, Cursor 

Initialize
Select Map
Map Setup
Nav Screens
Coord System
Map Datum
Elev Mode
Time Format
Units
Alarms
North Reference
Daylight Saving
Power Off Timer
Contrast
Light Timer
Beeper
Clear Memory
NMEA
Baud Rate
Power key
Simulate
Language

to Cursor
en Job
w Job
lose Job) Open Job

New Job
(Close Job)

Open Job
New Job
(Close Job)

Open Job
New Job
(Close Job)

Open Job
New Job
(Close Job)
In the previous chapters,
we have introduced most

of the context-sensitive
functions available from

the menu list. In fact,
these functions are

closely tied to
MobileMapper’s main

functionality (GIS data
logging and navigation).

In this chapter, we
present the supplemental

functions.

Show (Hide) Map Info
(Select Map Info)

From Map 
screen, Position 
mode

Show

From M
screen
mode

Go
Op
Ne
(C

Open Job
New Job
(Close Job)
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The second diagram shows the available functions when 
pressing MENU when a GIS job is open and one of the GIS 
logging-specific screens is displayed.

When data logging is in progress and one of the navigation 
screens is displayed, then the functions specific to the select-
ed navigation screen and to GIS data logging add up in the 
menu (functions specific to data logging are listed first).
(See also Routes option, page 49, for which the MENU but-
ton gives access to specific functions.)
When you select the Setup option in the menu list, another 
menu is displayed containing a number of options, as shown 
in the above two diagrams.
All the options available from the Menu screen are described 
below.

 Feature

feature name>
<feature name>

ture being logged

Pause/Resume <feature name>
Repeat Feature
Offset
Close <feature name>
Nest Feature
Logging Interval
Delete <feature name>

Line or area feature being logged

Repeat Feature
Offset
Close <feature name>
Nest Feature

Grid feature 
being logged

Mark
GOTO
Routes
Setup
Delete Files
About...

Initialize
Select Map
Map Setup
Nav Screens
Coord System
Map Datum
Elev Mode
Time Format
Units
Alarms
North Reference
Daylight Saving
Power Off Timer
Contrast
Light Timer
Beeper
Clear Memory
NMEA
Baud Rate
Power key
Simulate
Language
(Repeat Feature)
Close Job

Repeat
Offset
Close <
Delete 

From feature list 
screen

Point fea
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Open Job
This option provides another way of opening a GIS job. It is 
similar to selecting the Open Existing Job option that is 
prompted on the screen after pressing the LOG button when 
no job is open yet. Selecting this option when a job is already 
open allows you to close the currently open job and open an-
other one.

New Job
This option provides another way of creating a new GIS job. 
It is similar to selecting the Create New Job option that is 
prompted on the screen after pressing the LOG button when 
no job is open yet.

Mark
This option allows you to quickly create a new waypoint 
whose coordinates will be those of your current location.
A typical use of this option is when you are located at a new 
point of interest and you wish to log its position.
When you select Mark in the menu list, MobileMapper dis-
plays the Mark screen with the following default values:
-  Default icon in the Icon field
- “WPTxxx” as waypoint name in the Name field. “xxx” is 

a number that MobileMapper automatically increments 
as you create new waypoints

- Coordinates of your current location in the Location and 
Elevation fields

If you agree with all these parameters, and as the Save field 
is already selected at the bottom of the screen, you just have 
to press ENTER to create the new waypoint. This is the fast-
est procedure to create a new waypoint.
On the other hand, if you have to change any of these param-
eters or add a comment in the Message field, then you have 
first to edit the corresponding fields before selecting the Save 
field and pressing ENTER
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Delete WPT
Replace WPT
Save Route

From View/Edit 
Route screen

Open Job
New Job
(Close Job)
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Setup
About...

Activate Route
View/Edit Route
Reverse Route
Delete Route
Save Trk to Rte
Map View Route

Deactivate Route
Select Leg
View/Edit Route
Reverse Route
Delete Route
Save Trk to Rte
Map View Route

From Route List 
screen, route high-
lighted and activated

From Route list 
screen, route 
highlighted, not 
activated

From Route List 
screen, empty 
route highlighted

Create New Rte
Save Trk to Rte

Open Job
New Job
(Close Job)

Open Job
New Job
(Close Job)

Open Job
New Job
(Close Job)

GOTO
This option is discussed in detail on page 39.

Routes
This option is discussed in detail on page 43. The MENU 
button gives access to a list of specific options when the 
Routes option is enabled. This is summarized in the diagram 
below.

Setup Menu
This menu contains most of the ancillary functions intro-
duced at the beginning of this chapter. Each of these func-
tions is described below.
1. Initialize

This option guides you through the complete procedure 
that allows you, any time, to initialize MobileMapper.
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2. Select Map
This option is mainly used to choose the base map used 
as background map on the Map screen. The following 
parameters can be set on the Change Map screen:
- Basemap: If no SD card containing a specific map is 

installed in MobileMapper, then only the Default Map 
option can be selected in this field. The default map is 
always present in MobileMapper. If an SD card con-
taining specific maps is installed in the receiver, then 
you can choose one of them as the one shown on the 
Map screen.

- Detail Map: If no SD card containing a specific map is 
installed in MobileMapper, then only the Empty 
option can be selected in this field as the default map 
only has one level of details. If an SD card containing 
specific maps is installed in the receiver and you 
chose one of them in the previous field, then you can 
choose the level of details you wish to see on the Map 
screen.

After choosing the desired options for these parameters, 
highlight the Save field at the bottom of the screen using 
the down arrow and then press ENTER.

3. Map Setup
This option allows you to set the viewing options for the 
Map screen (see page 28).

4. Nav Screens
This option allows you to remove the navigation screens 
that you do not need from the navigation screen sequence 
that you scroll by pressing NAV repeatedly (see 
page 26).
When selecting this option, you are asked to turn off or 
on each of the available navigation screens. Choose 
“Off” and press ENTER for all these screens that you are 
not currently using. Note that the Map screen cannot be 
turned off. You must cycle through all the screens in 
order to save any changes to the On/Off status of any 
screen.
Change Map screen
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5. Coord System
This option allows you to define a primary coordinate 
system, and also a secondary coordinate system if you 
need one.
By defining a coordinate system, you tell MobileMapper 
how the calculated coordinates should be expressed. For 
example, if you choose Lat/Lon, all coordinates will be 
expressed as angles (latitudes and longitudes) and if you 
choose UTM or any other system, coordinates will all be 
distances (Northings and Eastings) from the chosen ori-
gin.
When you select the Coord System option from the Setup 
menu, MobileMapper asks you to specify which system 
you want to define (primary or secondary). Select it and 
press ENTER. In the list that appears, select the coordi-
nate system you want to use and press ENTER. Depend-
ing on your choice, MobileMapper may then ask you 
additional information:
- Lat/lon display format
- Distance units if you chose another system (other 

than UTM). If for example a calculated coordinate is 
249173N and you choose 1 meter as distance unit, 
then the coordinate will appear as 249173N on the 
Position screen, or 24917N if you choose 10 meters, 
or 2491N if you choose 100 meters, etc.

- For some systems, information on grid zones or types
- For the User Grid, projection type (Transverse Mer-

cator, Lambert Conic, Stereographic, Oblique Merca-
tor or Polyconic), coordinates of origin, scale factor, 
unit to meters conversion and false Easting and 
Northing at origin
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6. Map Datum
This option allows you to define a primary map datum, 
and also a secondary map datum if you need one.
A map datum is a geographic reference that MobileMap-
per will refer to to calculate the coordinates of your posi-
tion. MobileMapper holds more than 70 different map 
datums in its memory.
After selecting the Map Datum option from the Setup 
menu, choose the map datum from the list that applies to 
your country and working area and then press ENTER.

7. Elev Mode
This option allows you to choose between 3D and 2D 
mode.
In 3D mode, MobileMapper will compute the 3 coordi-
nates of your position: horizontal coordinates plus eleva-
tion. 
In 2D mode, MobileMapper will not calculate your ele-
vation. Only the horizontal coordinates of your position 
will be computed. MobileMapper will assume that the 
last computed or entered elevation is your current eleva-
tion.
Operating in 3D requires at least 4 tracked satellites 
whereas 2D requires only 3.
Consider using the 2D mode when the conditions of 
reception are poor or if the working area is relatively flat 
and elevation is not important.
After selecting the Elev Mode option from the Setup menu, 
choose the mode that matches your case of use and then 
press ENTER.
Default Map datums
 Primary: WGS84

Secondary: WGS84

Default Elev mode: 3D
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8. Time Format
This option allows you to select the time format you 
want to use in MobileMapper. You can choose from three 
different time formats: Local 24Hrs, Local AM/PM or 
UTC.
After selecting the Time Format option from the Setup 
menu, choose the time format that suits you and then 
press ENTER.
If you have selected Local 24 Hrs or Local AM/PM, you will 
be prompted to enter your local time.

9. Units
This option allows you to select the units of measure-
ment that will be used when displaying navigational data 
or features being logged.
All sets of units are formatted as follows: long distance 
unit/short distance unit/speed unit/area unit.You can select 
from 5 different sets of units.
You can also create your own set of units by selecting 
Advanced at the end of the list. You are then prompted to 
specify the unit you wish to use for each type of possible 
measure, i.e. Distance, Speed, Elevation, Bearing and 
Area.
After selecting the Units option from the Setup menu, 
choose a set of units from the displayed list and then 
press ENTER. If you have selected Advanced, a new list 
appears prompting you to choose a unit for each type of 
measure. Select the first measure in the list, press 
ENTER, choose a unit and press ENTER again. This 
takes you back to the former screen where you can select 
the second measure, etc. When all units are defined, 
press ESC to come back to the Setup menu.
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10.Alarms
All of the Alarm options are set in the same way. The 
instructions below apply to all of the Alarm settings. 
When the beeper is turned on for alarms (see Beeper 
option) an audible beep will be sounded for the alarm. A 
visual alert is displayed for the alarm whether the beeper 
is turned on or off.
Setting the Arrival Alarm: The arrival alarm alerts you 
that you have arrived at the destination of your GOTO 
route or to the destination of any leg in a route you are 
navigating on. This option allows you to set the distance, 
in the measurement units you selected, from the destina-
tion at which the alarm will begin to sound.
Setting the PDOP Alarm: This turns on or off the alarm 
that can sound whenever MobileMapper has lost its abil-
ity to compute accurate position fixes due to poor geom-
etry of the GPS constellation. Generally, PDOP values 
less than or equal to “5” are indicative of good operating 
conditions. So it is a good idea to set this alarm to “5.” To 
turn off the PDOP alarm, enter “00.”

NOTE:
Apart from the Arrival and PDOP alarms, MobileMapper 
will generate a warning message on the screen in each of 
the following two cases:
- “Low Memory.” This message will appear when the 

handheld is running out of memory. If a job is being 
logged, then the occurrence of this message will auto-
matically stop GIS data logging. You will however be 
allowed to enter the attribute values of the current 
feature before the job is closed.

- “Out of Memory.” This message will appear when 
the memory is full. The occurrence of this message 
will immediately close the currently open job and 
you will not be able to log any new feature until you 
free some space in memory.
Alarms menu
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11.North Reference
This option allows you to define the type of North refer-
ence you want MobileMapper to use. This can be True 
North, Magnetic North, Military True North or Military 
Magnetic North.
After selecting the North Reference option from the Setup 
menu, choose the desired North Reference from the dis-
played list and then press ENTER.

12.Daylight Saving
This option allows you to select the region where you are 
located so that MobileMapper can automatically adjust 
the time displayed to compensate for daylight saving 
time. You can select one of three possible regions:
- United States: Daylight saving starts on the first Sun-

day in April and ends on the last Sunday in October
- European Union: Daylight saving starts on the last Sun-

day in March and ends on the last Sunday in October
- Customize: this option allows you to set the month and 

day that daylight saving starts and ends in your area.
After selecting the Daylight saving option from the Setup 
menu, press ENTER again to list the three available 
regions. Choose one using the up/down arrow and then 
press ENTER. Press ESC to come back to the Setup 
Menu screen. If you chose Customize, first set all the dis-
played fields according to your local daylight saving 
times before pressing ESC.
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13.Power Off Timer
Conserving battery life is important to any handheld GPS 
user. The Power Off Timer option provides another tool 
in saving battery life.
Selecting On will allow you to select the mode and how 
long MobileMapper will stay powered on.

- If the Power off mode you select is Time, then the Power off 
Timer field allows you to select time that MobileMapper 
will remain on before automatically powering off is no 
keys are pressed (1 2, 4, 10, 30 or 60 minutes).
If the Power off mode you select is Position, the Power Off 
Timer field sets how soon MobileMapper will be powered 
down when the position has not changed and if no keys 
have been pressed.

14.Contrast
This option allows you to set the screen contrast. After 
selecting this option, a new screen appears on which you 
can set the percentage of contrast using the left/right 
arrows to respectively decrease or increase that percent-
age. The impact of your contrast setting upon different 
color bars is instantly shown in the lower part of the 
screen.

15.Light Timer
This option allows you to set the time interval that will 
be used to turn off the display backlight when not in use. 
Times available are: 30 seconds, 1, 2, 4 or 10 minutes, or 
Timer Off.
After selecting the Light Timer option from the Setup 
menu, use the up/down arrow to highlight the desired 
choice and then press ENTER.
Default: Off

It’s a good idea to use
this option when you

transport your
MobileMapper unpro-

tected in a bag. This will
prevent the batteries from

being entirely dis-
charged after the PWR

button has been inadvert-
ently depressed.

Default: 4 minutes
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16.Beeper
This option allows you to select which actions will cause 
the beeper to sound. You can select one of the following 
choices:
- Off (beeper will never sound)
- Keys Only (pressing a key causes a beep)
- Alarms Only (when an alarm is activated)
- Keys & Alarms (beeper will sound when a key is 

pressed or an alarm is activated)
After selecting the Beeper option from the Setup menu, 
use the up/down arrow to highlight the desired choice 
and then press ENTER.

17.Clear Memory
This option allows you to clear one of the following data 
sets from MobileMapper’s memory:
- Track history: Will clear the track history displayed on 

the Map screen from memory 
- Wpts/Routes: Will clear all waypoints and routes from 

memory
- Routes: Will clear all routes from memory
- Reset default: Will reset the receiver by restoring all 

factory defaults
- All: Will clear all memory

After selecting the Clear Memory option from the Setup 
menu, use the up/down arrow to highlight the desired 
choice and then press ENTER. MobileMapper will ask 
you to confirm your choice. If you have selected All, 
MobileMapper will then shut off. The next time it is 
turned on, it will prompt you that it needs to be initial-
ized.
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18.NMEA
This option allows you to select the NMEA message that 
will be output from MobileMapper. Your choice will 
depend on which message is needed by the device con-
nected to MobileMapper:
- V1.5 APA: Autopilot Sentence “A”
- V1.5 XTE: Crosstrack error according to NMEA0183 

V1.5
- V2.1 GSA: Standard GPS position message according 

to NMEA0183 standard in version 2.1
After selecting the NMEA option from the Setup menu, 
use the up/down arrow to highlight the desired choice 
and then press ENTER.

19.Baud Rate
This option enables you to set the baud rate of the data 
being sent out from the MobileMapper’s output port. The 
possible choices are: 1200, 4800, 9600, 19200, 57600 or 
115200 baud.
After selecting the Baud Rate option from the Setup menu, 
use the up/down arrow to highlight the desired choice 
and then press ENTER.
 Www.Somanuals.com. All Manuals Search And Download.



Default: No protection
Download fr
20.Power Key
This option allows you to change how the PWR button 
operates in turning MobileMapper on or off. Two choices 
are possible:
- No protection: this is the normal case of use. With this 

option enabled, you will have to press the PWR but-
ton to turn MobileMapper on. You will press the 
PWR button again to turn MobileMapper off.

- On/Off protected: To turn MobileMapper on with this 
option enabled, you will have to press and hold the 
PWR button until the first screen is displayed. To turn 
it off, you will have to press the PWR button, and 
then press the ENTER button before the power off 
timer is done.

After selecting the Power Key option from the Setup 
menu, use the up/down arrow to highlight the desired 
choice and then press ENTER.

21.Simulate
This option allows you to set the simulator. It shows you how 
MobileMapper uses its various functions based on a simulat-
ed journey. The simulator is useful for learning or demon-
strating MobileMapper functions when indoors and there is 
no GPS reception. When the simulator is on, MobileMapper 
quits normal operation to operate in the simulator mode. You 
can choose one of the following three options when you ac-
cess the Simulate option:

- Off: Will turn the simulator off. MobileMapper will 
return to normal operation

- Auto: Will turn the simulator on. A predefined head-
ing and speed rate will be used.

- User: Will turn the simulator on. A user-defined head-
ing and speed rate will be used.
59

om Www.Somanuals.com. All Manuals Search And Download.



60

Download from
After selecting the Simulate option from the Setup menu, 
use the up/down arrow to highlight the desired choice 
and then press ENTER.
If you have selected User, MobileMapper will then ask 
you to enter heading and speed data. A message will then 
appear warning you that enabling the simulator will nec-
essarily clear track history. Make the appropriate choice.
If you have selected Auto, MobileMapper will also dis-
play the warning message about track history.

22.Language
This option allows you to select the language that 
MobileMapper will use to display text.
TIP: If you change the language setting in MobileMap-
per just to see what it looks like and need to get back to 
the Language Select screen, follow these instructions. 
Press NAV until the Satellite Status screen is displayed 
and press MENU. Select the sixth item in the list and 
press ENTER. Press the up arrow once and press 
ENTER. You are back at the Language Select screen.
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Delete Files
This option allows you to list the job files stored in memory. 
Use the up/down arrow to scroll through the list.
A symbol is placed before each filename. The meaning of 
this symbol is as follows:

> Indicates that this file is the current file into which data 
is being recorded
+ Indicates that the file has not yet been downloaded 
from the handheld
- Indicates that the file has been downloaded from the 
handheld.

Pressing ENTER will display the File Info dialog box show-
ing the name, size and creation date for the job file you have 
highlighted in the list.
You can delete this file by pressing ENTER again (Delete 
field already highlighted) or you can come back to the job 
file list by pressing ESC.

About...
The About... screen displays the current status of your Mo-
bileMapper. Using the About... screen you can tell what the 
version of the software is, the version and memory size of 
the base map, the number of and total memory size of de-
tailed maps you may have installed, and how much free 
memory is available.
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2. MobileMapper Office Software
Introduction
The functions supported by MobileMapper Office are listed 
below:
- Creating Job files. A job should always contain a feature 

library. The name of the coordinate system selected in 
the program is also automatically attached to the job. The 
following information will also be saved to the job if the 
relevant data is displayed in MobileMapper Office: 
names of waypoint/route files and name of background 
map.

- Uploading job files to the MobileMapper handheld so 
that field operators can revisit previously completed jobs. 
When you do that, not only do you upload GPS positions 
and descriptions of the previously visited features but 
also the name of the coordinate system used in the job, 
the complete feature library associated with this job, and 
possibly the names of the background map and way-
point/route file attached to this job.

- Downloading completed job files from the MobileMap-
per handheld. Again, when you do that, the name of the 
coordinate system used in the job, the complete feature 
library associated with this job, and optionally the names 
of the background map and waypoint/route file attached 
to this job are downloaded in addition to the GPS posi-
tions and descriptions of the visited features. 

- Exporting jobs in GIS formats (SHP, MIF, DXF). Note 
that exporting to DXF requires that a grid system, not a 
lat/lon system, be used in the job.

- Creating standalone feature libraries using the Feature 
Library Editor. GIS layers can be imported from your 
GIS system when you create a feature library.

- Creating lists of waypoints and routes using the Way-
point/Route Editor.
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- Creating background maps using the Background Map 
and Create Map utilities. When you create a background 
map, you can import SHP, DXF or MIF files to add use-
ful details to your map. Remember however that back-
ground maps are for viewing only. You cannot edit them 
or access information on their features. They provide a 
backdrop, which gives visual orientation for your data 
and waypoint files. If you want to edit the positions or 
descriptions of a SHP, MIF or DXF file, you should 
import them into a MobileMapper job file.

- Uploading individually any standalone feature library 
file or background map to the MobileMapper handheld.

- Downloading individually any standalone feature library 
file, background map file or waypoint/route file.

- Defining the coordinate system used by MobileMapper 
Office to display the coordinates of features and way-
points.

Installing MobileMapper Office
- Close all the applications running in Windows
- Insert the installation CD-ROM in the drive
- If the Autorun program does not start automatically from 

the CD-ROM, in the Windows task bar, click on Start 
and select Run...

- Type x:\setup (where x is the name of the CD-ROM 
drive) and then press Enter. After you specify where to 
install MobileMapper Office programs, and you agree to 
the terms of the software license, your computer will 
complete the installation process.

Launching MobileMapper Office
On the Window Task bar, select successively Start, Programs 
and MobileMapper Office. This starts the program causing the 
main window to open on the PC screen. You may alterna-
tively start just the Feature Library Editor or the Mo-
bileMapper Transfer utility in order to use these standalone 
applications.
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MobileMapper Office Main Window

The main window of MobileMapper Office is organized as 
explained below (see also above figure):
- The Map Display area runs from the bottom of the Menu 

bar to the bottom border. It takes up about two-thirds of 
the screen, right to left.

- At the bottom of the window, in the status bar, a box is 
used for displaying the geographic location of the cursor 
in the selected coordinate system

- The right third of the window is used to display the Layer 
List. When opened, the window relevant to the Way-
points or Routes List is placed over the Layer List.

- The Create Map editor and the Feature Library Editor are 
each displayed in a secondary window that appears at the 
center of the screen.

Map Display area Layer List
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Map Display Area
Controlling the Content of the Map Display Area
The data displayed in the Map Display area is controlled by 
the Layers List shown on the right-hand area of the main 
window.
When you want one of the listed layers displayed in the Map 
Display area, just fill in the check box located before this 
layer name. As a result, all the items pertaining to this layer 
will be shown in the Map Display area. Conversely, if you 
clear the check box, none of the items pertaining to this layer 
will be visible in this area.
By default, the following two layers are always displayed:
- Waypoints
- Background map
If a job is open, each feature from the feature library used in 
the job also appears as a layer which can be displayed/hidden 
on the Map Display area. In addition, for these layers, you 
can change their look on the Map Display area by double-
clicking on their names. Different icons are available for 
point features and different colors are available for line, area 
and grid features.
If you import a MIF or SHP file from your GIS system, then 
new layers will also be added to the Layer list.
A number of viewing options are also available from the bot-
tom of the Options menu to let you customize the Map Dis-
play area. You can for example show/hide the grid values, 
the scale interval, the feature and waypoint labels, etc.
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Below is the list of buttons from the Map toolbar that you 
can use to work on the content the Map Display area:

: Allow you to respectively zoom in, zoom out 
and fit the scale to the map content

: Allows you to adjust the scale to preset values

: Allows you to drag the map in any direction.

: Allows you to select the map of a continent for 
display in the Map Display area as a backdrop to the job 
data (and also to the background map itself, if displayed).

: Gives access to the Background Maps dialog from 
which you can attach/detach a background map for the 
currently open job

: (Gives access to the Feature Library Editor window; 
not a map-related button)

: Allows you to measure distances on the map. See 
next chapter.

: Allows you to define a map region

: Allows you to place new waypoints on the Map 
Display area

: Allows you to draw routes connecting waypoints 
shown on the map
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Making Measurements on the Map Display Area
You can measure the distance and heading between any 
points displayed in the Map Display area:

- On the toolbar, click , then click on the point on the 
map from which to start the measurement. The start point 
is then marked with a small square symbol.

- Then, as you move the mouse cursor away from the start 
point, MobileMapper Office will calculate the length and 
heading from the current location of the cursor to this 
point

- If you click on a second point, a straight line will appear 
on the map between the start point and the second point. 
MobileMapper Office will also start calculating the dis-
tance and heading from the current location of the cursor 
to the second point, plus the total length from the mea-
surement’s start point.

- To stop measuring distances and headings on the map, 
press the Esc key.

Deleting Features
You can delete features from the Map Display area, and so 
from the open job, using the following procedure:
- Make sure none of the buttons on the toolbar are active
- Click on the feature you want to delete. The feature then 

appears surrounded by a thick pink frame
- On the menu bar, select Tools>Delete Feature, or on the 

keyboard, press the Del key. A warning message asks 
you to confirm the delete operation

- Click the Yes button to let MobileMapper Office delete 
the feature, or the No button to cancel this operation.
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Working on Job Files
Creating a New Job
Before you ask field operators to create a new job, you just 
need to create the appropriate feature library and upload it to 
their handhelds. Field operators will then just have to create 
a new job based on this feature library. But you can also pre-
pare an “empty” job using the procedure below and ask field 
operators to open that job for their field operations. By 
“empty job” we mean “with no features logged yet in the 
job.” But this empty job can contain waypoints, routes and a 
background map as explained below.
You create job files using the New command from the File 
menu. Select Save from the File menu, type in a name for the 
job and click the Save button to create a new *.mmj file in the 
Docs folder (default folder).
A job file cannot do without a feature library as field opera-
tors do need a feature library to complete their jobs. That is 
why you have to import a feature library –created earlier– 
into the job before uploading the job to the handheld. You 
can do that using the Import command from the File menu, 
specifying the Feature Library Files option in the Files of Type 
field, selecting the feature library to associate with the job 
and then clicking Open. As a result, all the features read from 
this library will appear as layers in the job.
You can also add waypoints, routes and a background map 
to be part of the job. This is simply done by saving the job 
when a waypoint/route list displayed in the right-hand part 
of the screen and a background map is attached to the job and 
shown in the Map Display area.
The coordinate system attached to the job will be the one 
currently selected in MobileMapper Office. This informa-
tion will be required in the handheld if you have created a list 
of waypoints in the job so that the handheld can identify the 
coordinate system used to express these waypoint coordi-
nates.
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Connecting the Handheld to the PC
- Connect the MobileMapper handheld to one of the serial 

ports on your office PC using the serial cable provided 
with the handheld

- If you are connecting the handheld to the PC for the first 
time, do the following: 
• On the menu bar, select Options and then GPS Set-

tings...
• In the dialog box that opens, click Autodetect. 

MobileMapper then starts a sequence to determine 
the port that MobileMapper is connected to, as well 
as the baud rate used on the receiver side. At the end 
of this sequence, the message “Found MobileMap-
per” should appear as the status of one of the ports

• Click OK to close the dialog box.
- If communication has already been established with the 

receiver during this working session and you want to 
make sure MobileMapper Office is still communicating 
with the handheld, do the following:
• On the menu bar, select Options and then GPS Set-

tings...
• In the dialog box that opens, click Test. MobileMap-

per then tests the data link to the receiver, indicating 
which baud rate is used during this test. The message 
“Found MobileMapper” should appear as the status 
of the port connected to the handheld.

• Click OK to close the dialog box.
 Www.Somanuals.com. All Manuals Search And Download.



You must make sure that
the SD card is inserted

into the receiver to
ensure proper data

transfer between the
handheld and

MobileMapper Office

Download fr
Uploading a Job to the Handheld
First of all, you have to connect the handheld to the PC run-
ning MobileMapper Office and test the connection, as ex-
plained in the previous chapter.
- Open the file job in MobileMapper Office using the 

File>Open command. Job filenames are in the form 
“*.mmj”.

- On the menu bar of the MobileMapper Office main win-
dow, select File, Upload to GPS and Job.... MobileMapper 
Office then routinely searches for the right baud rate to 
communicate with the handheld. When communication 
is established with the handheld, the upload sequence is 
automatically started. A dialog box keeps you informed 
on the file being transferred. A message is also displayed 
on the handheld informing you that file transfer is in 
progress. These two indications disappear from the PC 
and handheld screens when data transfer is complete.
IMPORTANT! When you upload a job file, not only do 
you upload all the logged features, if any, contained in 
this job, but also the feature library attached to the job.  
All MobileMapper job files include a feature library.
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Downloading a Completed Job from the Handheld
MobileMapper Office uses the MobileMapper Transfer util-
ity as an interface program to access the files stored on the 
MobileMapper handheld.
First of all, you have to connect the handheld to the PC run-
ning MobileMapper Office and test the connection, as ex-
plained on page 70.
- On the menu bar, select File>Download from GPS. This 

opens the MobileMapper Transfer window on your 
screen.

The right-hand pane lists all the files present in the 
default directory (...\Docs) on your PC (see example 
above). The left-hand pane will list the files stored on the 
handheld once the connection to this device is estab-
lished.

- To connect to the handheld, on the menu bar at the top, 
select successively File>Connect>GPS Device via Cable. This 
will cause the transfer utility to routinely test which baud 
rate should be used to communicate with the handheld. 
Once communication is established, the transfer utility 
starts reading the content of the handheld’s memory.
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After a while, the window’s left-hand pane should list the 
content of the handheld’s memory.

1. Downloading a job file
- Drag and drop this file from the left-hand pane to the 

right-hand pane.
- Close the MobileMapper Transfer window. This will 

cause the downloaded job to be imported into the cur-
rently open job, provided both jobs use the same fea-
ture library. Otherwise a message will warn you that 
importing this job is impossible.
The Import operation performed in the job download-
ing context is similar to using the Import command 
from the File menu. With this function, the down-
loaded data will automatically add up to the data of 
the currently open job. This means that you can 
merge multiple job files created for a single project 
before exporting the whole data to your GIS. In this 
particular case, it is indeed very likely that all these 
job files were created based on the same feature 
library.

2. Deleting a file from the handheld
- Select this file in the left-hand pane and press the Del 

key. MobileMapper Office then asks you to confirm 
that you want to delete the file. Click Yes if that is 
what you really want to do.
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If you access the Feature
Library Editor after

opening a downloaded
job, this window will

show the definition of the
feature library that was

used to create the job.
Unlike a standalone fea-

ture library, you CAN-
NOT edit a feature

library attached to a job.
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Viewing the Content of a Job
After downloading a completed job in MobileMapper Office 
as explained in the previous chapter, you can also open it in 
MobileMapper Office using the File>Open command. As a re-
sult, MobileMapper Office shows the content of this job in 
the main window. First of all, you can see the list of layers 
present in this job in the right-hand part of the screen. Clear 
or check the buttons for the layers you want to see in the Map 
Display area. If enabled for display, the background map 
shown is the one currently selected in the Background Map 
List.
Now the main purpose of viewing a job in MobileMapper 
Office is to get a view of the features that were logged during 
field operations. If enabled for display, these features are 
represented on the Map Display area according to the view-
ing choices made for the corresponding layers. You can do 
more than just view these features. You can also view the 
conditions in which these features were logged. To do that, 
just click on these features, one after the other in the Map 
Display area. This opens a new window in which you can see 
the properties of these features. In the example below, Mo-
bileMapper Office shows the properties of a line feature:
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Exporting Jobs in GIS Formats
The most important processing of your field data is its export 
to a GIS. Exporting field data has two processes: conversion 
of the data files to a standard format a GIS can read and then 
the actual transfer of the file.
To convert your data into SHP, MIF or DXF:
- On the menu bar, select File>Open to list the job files in 

MobileMapper Office
- Select the file you want to export and click Open. The 

content of this file is now displayed on the screen.
- Select File>Export.
- Choose the export format (SHP, MIF, DXF -or MMF, see 

opposite) from the Files of type field.
- Select the directory to which the reformatted file will be 

transferred. If you don't know where to put this file, just 
select a temporary location and click Export. Your job 
will be automatically formatted and transferred to the 
selected folder. You can select any folder that is accessi-
ble by your PC - including any GIS folders that may be 
on your network. When you start recording data to 
export to a GIS, you will typically export data to a GIS 
database.
When exporting a job file to SHP format, the following 
files are created for each feature type (layer, theme) in 
the file:
- featurename.shp
- featurename.dbf
- featurename.shx

When exporting a job file to MIF format, the following 
files are created for each feature type (layer, theme) in 
the file:
- featurename.mif
- featurename.mid

A single DXF file is created for each existing feature 
type when exporting a job to DXF format.
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Note the following limits
for feature libraries:
No. of feature types:

15 max.
No. of attributes

per feature: 10 max.
No. of attributes values

per Menu-style attribute:
5 max.
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Using the Feature Library Editor
Introduction
MobileMapper Office allows you to create new feature li-
braries using the Feature Library Editor.
Feature libraries are used by field operators as a common ba-
sis for describing the features they visit in the field.
A feature library describes a number of features that Mo-
bileMapper operators will have to visit in the field. Each fea-
ture is defined as a set of attributes. In fact, it will be the task 
of field operators to provide an attribute value for each at-
tribute of a feature, depending on what they see or measure 
when they are near this feature. The diagram below shows 
the general architecture of a feature library through a simple 
example.

Feature Library
Hydrant

xxx...

xxx...

Color

Height

Address

Red
(Attribute #1)

(Feature #1)

Orange

Any value between
(Attribute #2)
(Numeric type)

(Street Address)

Gray

(Menu type)

0.0 and 1.5 m

(Attribute #3)
(Text type)

Any character string
20 char. max. in length

Op
tio
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 in

 th
e m

en
u

(Feature #2)

(Feature #n)

(Attribute values)
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There are four different types of features:
- Point feature: This feature can be described as a point, 

geometrically speaking. Field operators should log point 
features in static mode, i.e. they are supposed to stay sta-
tionary at these points for at least one second.

- Line feature: This feature can be described as a line. 
Field operators should log line features in kinematic 
mode, i.e. they should start logging this type of feature at 
the beginning of the line, move along this line and stop 
logging when reaching the end of the line.

- Area feature: This feature can be described as an area. 
Field operators can log area features either in kinematic 
mode (general case) or in “multi-static” mode in case of 
areas with regular (straight) contours.

- Grid feature: This feature defines an array of evenly 
distributed waypoints where field operators record obser-
vations or make measurements using some instrument. 
In-depth information on grid features is given on page 
86.

There are three different types of attributes:
- Menu style: the attribute value can only be one of the 

preset values from a user-defined menu
- Numeric style: the attribute value can only be within a 

pre-defined range of numeric values
- Text style: the attribute value is in text form and should 

not exceed the permitted length (20 characters).
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Creating a New, Standalone Feature Library File
- On the menu bar, select Tools, then Feature Library Editor. 

This opens the Feature Library Editor window at the cen-
ter of the screen.
Warning! If a job is open in MobileMapper Office’s 
main window, the Feature Library Editor window then 
shows the feature library used in the open job. This 
library cannot be changed. That’s why you have to do the 
following.

- On the menu bar, select File, then Save As... A new dialog 
box opens in which you can name and choose the folder 
where to store the new feature library. The default folder 
is .../Docs. It is a good idea to group all feature library 
files in the “Docs” default folder. These files can only be 
saved as “mmf” files as mentioned in the Save as type: 
field.

- Enter a name for the library in the File name: field. For 
example, type in “Libr#1” and click Save. The new name 
of the feature library now appears on the left-hand part of 
the Feature Library Editor window.
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idea to choose a name

that reflects the geometry
type of the feature. For

example, as the last 2
characters in the name,

you could use “Ln” for a
line feature, “Ar” for an
area feature, “Gd” for a

grid feature and “Pt” for
a point feature (although

point feature names are
often self-explanatory).

The reason for doing this
is that the field operator

will be able to rely on
feature names to clearly
identify the type of fea-
ture she/he selects from

the feature list.
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Inserting New Features to the Feature Library
- In the Feature Library Editor window, right-click on the 

feature library name and select Insert Feature. A new dia-
log box opens in which you can define the first feature 
for the library:

- Enter a name for this feature in the Feature Type Name field 
(see recommendations opposite).

- Indicate the type of the feature. For example, if the fea-
ture is a hydrant, check Point, if it’s a coast line, check 
Line, if it’s a car park, check Area, if it’s an area where 
measurements should be performed according to a preset 
array of waypoints, check Grid. Grid features are pre-
sented in detail in a separate chapter starting on page 86. 
Refer to this chapter if you need to define a new grid fea-
ture.

- Click the Add button. The Insert Feature Type dialog box 
is displayed one more time so that you can now define 
the second feature for the library.

- Indicate the type of the second feature as explained 
above and then click the Add button.

- Repeat the above steps until all the features have been 
defined.

- After defining the last feature, click the Close button.
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Defining Feature Attributes
- Under the feature library name, in the left-hand part of 

the Feature Library Editor window, select the first feature 
name, right-click on it and select Insert Attribute. A new 
dialog box opens where you can define the first attribute 
for the feature:

- Enter a name for this attribute in the Attribute Name field 
- Indicate the type of the attribute. There are three types of 

attributes: Menu, Numeric and Text. If the attribute con-
sists of a list of statements that the field operator will 
have to choose from, check Menu, if it refers to a number 
the field operator will have to enter, check Numeric, and if 
the feature refers to a description or any other alphanu-
meric string that the field operator will have to type in, 
check Text.

- Then click Add to add another attribute for the feature, or 
Close after the last attribute has been defined.

- Select the second feature on the left, right-click on it, 
select Insert Attribute and then define all the feature’s 
attributes as explained above. Click the Close button 
when it’s done.

- Repeat the above steps until all the attributes have been 
defined for all the features present in the library
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Defining Attribute Values
You define attribute values in the right-hand pane of the Fea-
ture library Editor window.
- Click on the name of the first attribute of the first feature. 

The right-hand pane of the Feature Library Editor win-
dow now shows a table containing the definition of this 
attribute. The highlighted cell is where you can enter the 
first attribute value for this attribute. Click on this cell.

- Type in the attribute value and press ENTER on your 
keyboard. A new row is added in the table where you can 
enter a second attribute value, etc.

- When you are done with the values of this attribute, click 
on the second attribute in the left-hand pane of the Fea-
ture Library Editor window. Resume the previous and 
present steps as many times as necessary.

- Example of attribute values (red, orange, gray) for one of 
the attributes (color) of a point feature (hydrant):

For a Menu style attribute, you should define a list of options 
the field operator will have to choose from.
For a Numeric style attribute, you should define the preci-
sion, default value and range of possible values for the at-
tribute (minimum and maximum values).
For a Text style attribute, you should define the maximum 
number of characters allowed and the default value for the 
attribute.
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Up to 22 different icons
are listed in this box.
The icon you choose

here will also be shown
on the receiver’s Map

screen during field oper-
ations dealing with fea-

tures of this type.
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Renaming a Feature, Defining its Representation 
on the Map
Still from the Feature Library Editor window, you can 
change the name of a feature as explained below:
-  In the left-hand pane of the window, click on the feature 

name you want to edit. This displays the Feature Type 
table on the right.

- Double-click on the cell containing the feature name (see 
example below) and type in a new name

- Press the Enter key to record the change.

From the same table, you can also change the shape and as-
pect given to a feature on the map.
The representation of a point feature on the map is an icon 
that you can define as explained below:

- In the Icon row of this table, click . A new dialog box 
opens in which you can select a new icon for the feature:
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The representation of a line or area feature on the map is 
based on line properties that you can define as explained be-
low:

- In the Style/Color/Width row of this table, click . A 
new dialog box opens in which you can define the prop-
erties of the line representing the line feature or the con-
tour of the area feature (color, style and width):

Deleting Features, Attributes or Attribute Values
The Feature Library Editor lets you delete, in a very simple 
manner, any feature, attribute or attribute value option from 
the open Feature Library.
- To delete a feature, you just select its name and you press 

the Del key on your keyboard. Deletion is immediate as 
MobileMapper Office does not require user confirma-
tion. By deleting a feature, you also delete all attributes 
and attribute values attached to this feature.

- To delete an attribute from a feature, expand that feature 
in the left-hand pane of the Feature Library Editor win-
dow, select the attribute you want to delete and press Del 
on your keyboard. Deletion is immediate as MobileMap-
per Office does not require user confirmation. By delet-
ing an attribute, you also delete all attribute values 
attached to this attribute.
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- To delete an attribute value from the list of possible val-
ues of a Menu-style attribute, first select the concerned 
attribute in the left-hand pane of the Feature Library Edi-
tor window. Then in the right-hand pane of this window, 
highlight the cell containing the attribute value you want 
to delete and press Del on your keyboard. Deletion is 
immediate as MobileMapper Office does not require user 
confirmation.

Saving a Feature Library
When you are done with the definition of a feature library 
file, don’t forget to save the file by selecting File>Save on the 
menu bar of the Feature Library Editor window.

Attaching a Feature Library to a Job
When you want to attach a feature library to a GIS job, you 
just have to import this feature library into the job open in the 
main window, using the File>Import command. The features 
contained in the feature library will then appear as “layers” 
in that job. When you save the job, the complete feature li-
brary will also be saved in this job.
Similarly, when you open a job after downloading it from a 
MobileMapper handheld, then the features from the library 
file used for that job will automatically appear as layers per-
taining to the job. If you open the Feature Library Editor 
window in that case, then it’s the feature library used in that 
job that will be shown in this window.
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Importing a Feature Library from a Job or GIS File
Using the File>Import command in the Feature Library Editor 
window, you can import the feature library used in an exist-
ing job or from a MIF or SHP file.

Uploading a standalone feature library file
- Unless already done, select Tools>Feature Library Editor to 

open the Feature Library Editor window
- Open the feature library file you want to upload using the 

File>Open... command. Feature library filenames are in the 
form “*.mmf”. If you want to upload the feature library 
used in the open job, then you must save it as an mmf file 
from within the Feature library Editor window before 
you are allowed to upload this file to the handheld.

- On the menu bar of the Feature Library Editor window, 
select File and then Upload to GPS. MobileMapper Office 
then routinely searches for the right baud rate to commu-
nicate with the handheld. When communication is estab-
lished with the handheld, the upload sequence is 
automatically started. A dialog box keeps you informed 
on the file being transferred. A message is also displayed 
on the handheld informing you that file transfer is in 
progress. These two indications disappear from the PC 
and handheld screens when data transfer is complete.
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Grid Mapper Utility
Introduction
Working with the Grid Mapper Utility is an easy way to log 
GPS positions and GIS data at waypoints arranged in an 
evenly spaced grid. This allows you to gather measurements 
- made by field sensors such as depth sounders, chemical de-
tectors and magnetometers - in an organized fashion with an 
easy-to-use navigation feature. You can then create contour 
maps with the necessary density of data while avoiding any 
gaps that might force you to return to the field.

Grid Features vs. Grid Points
The Grid Mapper Utility refers to two different grid con-
cepts: grid features and grid points.
- Grid features are arrays of uniformly spaced points ori-

ented in rows and columns.
- Grid points are navigation features similar to routes. 

They are created by MobileMapper Office and uploaded 
to the handheld. You navigate to each grid point using 
MobileMapper and record your observations or measure-
ments using its data logging software.

Think of an apple orchard where the rows are about 15 feet 
(5 meters) apart and each tree is about 15 feet (5 meters) 
apart from the next tree in its row. The orchard is a grid fea-
ture. The location of each tree is a grid point. The number of 
apples on each tree is the attribute you wish to record.
Like a point, line or area feature, a grid feature is a feature 
geometry type. You can see the similarity in two ways:
- Just as a line or area feature is made of a string of point 

positions, a grid feature is a set of points.
- As with line and area features, a single feature type name 

corresponds to the entire grid feature. In a single job, you 
might record positions and descriptions of several line 
features classified as “roads” and two area features clas-
sified as “lakes.” And you might use one grid feature 
named “water depth” and one named “magnetic field.”
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However, line and area features differ from grid features in 
two important ways:
- The positions making up line and area features mark the 

locations of real things like roads, lakes, etc. But the 
points making up a grid feature are imaginary target 
locations that you navigate to.

- The attributes you record for a road or a lake pertain 
equally to each of the point positions making up feature, 
but you typically record different descriptions at each 
grid point making up the grid feature.

Setting up a Grid Feature in a Feature Library file
Use the Feature Library Editor window to set up a grid fea-
ture. To add a grid feature to the feature library:
- Right-click on the name of the feature library and select 

the Insert Feature  option. Then select Grid as the feature 
type

- Click on the Add button, then on the Close button.
- Then define the attributes of the point feature that you 

will record at each of the grid points. Do this as you 
would for any point, line or area feature (see pages  80 
and  81). Typically, these are text-type attributes for 
visual observations and numeric-type attributes for mea-
surements made with instruments. But it is also possible 
to record observations using a menu-type of attributes.

Editing the Grid Properties
When you are done adding attributes to the grid feature, you 
will see the grid symbol and the name of the grid feature in 
the tree display of the feature library. If you click on the 
name of the grid feature, you will see a two-column table on 
the right labeled “Feature Type.” This is where the default 
values of the grid feature are indicated. If you want to change 
any of these values, double click on the value and type in a 
new one.
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Name: Feature names like “pole,” “road” or “lake” make 
it easy to identify the geometry of point line and area fea-
tures. This is not so easy with grid features. You might 
find it helpful to insert the word “grid” into the name of 
grid features. However, there is a 10-character limit to 
the name length so you may prefer to name the grid types 
with distinctive names like “mag. field,” “H2O depth” or 
“CO2 conc.”
Geometry and # of attributes: Cannot be edited
Number of Columns /Number of Rows: The easiest 
way to determine how large the entire grid must be is to 
measure the area using a background map showing 
appropriate layers. You can draw a rectangle over the 
area to be mapped and measure the two sides of the rect-
angle in meters. Then divide each distance by the grid 
feature’s spacing. Imagine yourself standing at one of the 
two corners of the rectangle where the grid feature is 
arrayed in front of you and to your right. The number of 
columns is the length of the side of the rectangle to your 
right divided by the grid spacing (in meters). The number 
of rows is the length of the side of the rectangle in front 
of you divided by the grid spacing.
Heading: The default heading is 0º (due North). If you 
leave the heading at this default value it means that the 
grid feature will be arrayed to the north and east of your 
position because these are the directions in front of you 
and to your right. If you want the grid feature oriented in 
any other direction, just type in the compass direction 
that you will face when standing with the grid in front of 
you and to the right.
Grid spacingtep:  The default value for the distance 
between adjacent grid points is 50 meters. You can set 
this spacing to any number of meters you would like. 
This number will be automatically converted to any other 
distance unit is set in the receiver.
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When changing from the default 50 meters, keep in mind 
that the selected value will determine the density of mea-
surements. If this number is less than 5 meters or so, 
there is no point in using a Grid feature. Simply walk 
around and take samples by visually estimating the 
required density. If you increase the spacing, be sure the 
spacing supports the density of measurements you 
require.

Uploading the Grid Feature to the Receiver
You upload grid features to the receiver by uploading the 
feature library that contains it. You can either upload the fea-
ture library as a standalone library that the user in the field 
can select to record a new job. Or you can use MobileMap-
per Office to import the feature library into a job created in 
the office. Either way, you just have to click on File>Upload to 
GPS and select the file you want to use in the field.
If you want to inform the field user where to begin logging 
the grid feature, just create a waypoint in MobileMapper Of-
fice by clicking on Tools>Place Waypoints. Make sure you 
change the name from the default “WPT001” to a name tell-
ing the user that this is the point of beginning for logging a 
grid. Then upload this waypoint as described on page 71.
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Using the Waypoint/Route Editor
Introduction
The Waypoint/Route Editor allows you to easily create a list 
of waypoints that might be useful for the field operator when 
she/he is performing a GIS job. For example one of these 
waypoints may help to localize a hardly visible feature.
The Waypoint/Route Editor also allows you to build new 
routes, based on the existing list of waypoints.
To save your waypoints and routes, you just need to save the 
currently open job. When you do that and there are way-
points and routes in the job, then MobileMapper Office cre-
ates a separate wpt file containing this list of waypoints and 
routes.
 
Placing Waypoints

- First of all, click the down arrow next to  on the tool 
bar and select the region where your jobs are going to 
take place. As a result, a map of your region appears on 
the Map Display area.

- On the toolbar, click  and then draw a rectangle 
around the part of the map you want to enlarge. When 
releasing the mouse, the map scale is adjusted so the 
Map Display area only shows this part of the map.

- On the toolbar, click . This opens a new window in 
the right-hand part of the window where you can edit 
your definitions of waypoints.

- Click on the Map Display area where your first waypoint 
should be located. A waypoint icon now appears on the 
map with the name of the waypoint displayed next to it 
(see example opposite).
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- In the right-upper part of the window (see example oppo-
site), you can now make changes to the definition of this 
waypoint (name, coordinates, icon, optional comment).

- Next to this definition area, you can also define the name 
and icon for the next waypoint you will create

- When you are done with the definition of the first way-
point, create the second waypoint by clicking on the map 
where this second waypoint should be located. Again, 
you can adjust the definition of this waypoint in the 
right-upper part of the window, etc.
Note that a waypoint table is updated in the right-lower 
part of the window as you create new waypoints. You 
can scroll this table horizontally and edit each of the cells 
if necessary. The second column (Name) contains a 
check button allowing you to show/hide each waypoint 
icon & name on the Map Display area.

Creating Waypoints from the Waypoint Table
Another very quick way of creating new waypoints is to use 
the aforementioned waypoint table.
- Right-click anywhere over this table and select New Way-

point in the pop-up menu. As a result a new waypoint is 
added in the waypoint table with default parameters and 
“zero” coordinates.

- You can then edit each cell to complete the definition of 
the new waypoint. The waypoint will then appear on the 
map (if located within the area covered by this map).
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Finding a Waypoint on the Map
MobileMapper Office helps you locate rapidly a waypoint.
- In the waypoint table, right-click on the row containing 

the definition of the waypoint and select View. The map is 
then moved accordingly within the Map Display area so 
as to take the searched waypoint exactly at the center of 
the Map Display area.

Deleting Waypoints
Waypoints can only be deleted individually from the way-
point table.
- Select the row containing the waypoint you want to 

delete
- Press the Del key or right-click on the row and select 

Delete. Waypoints are deleted instantly, without user con-
firmation.

You can also delete all the existing waypoints and routes 
through a single operation by selecting the Clear All Waypoints 
option from the Tools menu. In that case, MobileMapper Of-
fice will prompt you to save all these waypoints and routes 
in a separate wpt file before actually deleting them from the 
waypoint table (i.e. from the currently open job). If you click 
Yes you will have to name the wpt file and specify the folder 
where to store that file.
 Www.Somanuals.com. All Manuals Search And Download.



Creating a four-way-
point route

Download fr
Building a Route
After you have created a number of waypoints as explained 
in the previous chapter, you can now define routes graphical-
ly. Follow the instructions below to do this.

- On the toolbar, click . This opens a new window in the 
right-upper part of the window where MobileMapper 
automatically creates a new route named “Route1” (if it’s 
the first one in the list) (see opposite). Note that 
MobileMapper Office continues to display the waypoint 
table below this window.

- Come back to the Map Display area and click on the 
waypoint that you want to define as the route’s start point

- Then click on the second point, then on the third, etc. 
Every time you click a new waypoint, “Finish” is dis-
played next to this waypoint which means you don’t 
have to do anything special to end the definition of the 
route. MobileMapper Office will “understand” that the 
route definition is complete when you proceed to another 
task in the software.
Note that you can edit the name of the route by double-
clicking on it. You can also remove a waypoint from the 
route by right-clicking on it and selecting Delete. The 
Map Display area is then updated to reflect that change 
in the definition of the route.
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Background Maps
Introduction
Background maps are designed to provide useful details on 
working areas. Field operators might like to see these details 
on their handheld screens as they progress in their jobs so 
that they can more easily go to the places they have to visit.
Background maps are for viewing only. You cannot edit 
them or access information on their features. They provide a 
backdrop, which gives visual orientation for your data and 
waypoint files.
Background maps are shown in the Map Display area of the 
MobileMapper Office main window. They are independent 
of jobs. Whether there is an open job or not, you can have a 
background map displayed in this area. You may create this 
background map once and then it can be used as a back-
ground for many jobs at a certain location.
Background map projects are created using the Create Map 
editor. The notion of “ background map project” allows you 
to define the different layers the background map will result 
from, plus a number of parameters, i.e. map scale setting, 
map name, etc. Use the Tools>Background Maps command to 
access the Create Map editor. Background map projects are 
saved as separate files with the “mmp” extension.
Once you have defined and saved a background map project, 
you will then have to use the Operations>Create Map command 
to build the actual background map for the open background 
map project.
Usually it takes time to create a map, so it would be a benefit 
to do that once. After the background map is created, it will 
appear in the Background Maps list with the given name, and 
it can be selected at any time as a background for various job 
data.
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A background map generally consists of a base map, plus ad-
ditional details that you can for example import from your 
GIS system. Thus, a background map is a stack of several 
layers, but as opposed to layers in a job file, which you can 
select on the Map Display area, the layers composing a back-
ground map result in a single, merged, raster-type map on the 
Map Display area, with no possibility to select any individ-
ual items shown on this map
MobileMapper Office can only take MIF, SHP and DXF 
shapefiles in WGS84 lat/lon as source data. This includes 
shapefiles from GIS files and MapSend maps.
All background maps are in WGS84, lat/lon.
When you upload a job file to the MobileMapper handheld, 
the background map currently shown in the Map Display 
area when you saved the job is NOT uploaded to the hand-
held as being part of the job. That’s why you will have to use 
the File>Upload to GPS>Background Map command to upload the 
background map separately to the handheld.
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Creating a New Background Map Project
- On the menu bar, select Tools and then Background Map. 

This opens the Background Maps window
- Click on the Create New... button. This opens the Create 

Map window from which you can create a new back-
ground map project:

- Type in a name for the background map project in the 
Map Name field.

- In the Map Scale field, choose a scale value above which 
the background map will NOT be displayed on the Map 
Display area or on the handheld screen. (This is used to 
hide the background map when the current scale value of 
the Map Display area in the office software or on the 
handheld’s Map screen is incompatible with the extent of 
this background map.)
(To be continued in next paragraph)
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Adding Layers to a Background Map Project
(Continued from previous paragraph.)
You can add as many layers as necessary to build a back-
ground map. Layers may be SHP files or MIF files.
For example you could export to SHP ou MIF the features of 
a completed job and then add them as layers to create a back-
ground map. In this case you would merge these features into 
the background map and so they would no longer be select-
able as individual entities on the Map Display area. 

- Click , or on the menu bar, select Layer>Add... A dia-
log box opens in which you should indicate the folder 
where to find the layer and then select the file corre-
sponding to that layer.

- In the combo box located in the lower part of the dialog 
box, select the coordinate system on which the layer to 
be added is based. (You are supposed to know this infor-
mation).

- Click on the Open button. The selected file now appears 
as a layer in the first row of the Create Map window:

- Resume the previous steps as many times as necessary to 
add all the layers you need for your background map.

- Select File and then Save or Save As. In the dialog box that 
opens, choose a folder and enter a name for the back-
ground map project you want to create. This project will 
have the “mmp” extension.

- Then click Save to save the project.
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Changing the Order of Layers
When you build the background map, the first layer you 
placed in the table will be brought to the front, and the last 
one will be sent to the back. Intermediate layers will occupy 
intermediate positions in the layer stack.
If one of your layers contains area features, it is important 
that this layer be placed at the bottom of the table otherwise 
all layers containing point or line features located within 
these area features would be hidden by these features.
To change the position of a layer in the table:
- Highlight the row containing this layer by clicking on 

any cell in this row

- Click or , or select Layer>Move Up or Move Down to 
move up or down the layer by one row. If necessary, 
repeat this step until the layer is at the right position in 
the table.

Removing Layers
- Highlight the layer you want to remove

- Click , or select Layer>Remove from the menu bar, or 
press the Del key. This instantly removes the layer from 
the table.
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Changing the Visual Aspect of Layers
You can customize each layer by clicking on the correspond-
ing leftmost cell in the table. This opens a dialog box in 
which you can choose the aspect you want for the layer when 
the background map is built up later. As you will probably 
notice, the available options are much similar to those avail-
able when creating features with the Feature Library Editor.
- For a point feature layer, you can choose the type of icon 

that will be used to represent all the features pertaining to 
the layer

- For a line feature layer, you can choose the color and 
width of the line representing all the features pertaining 
to the layer

- For an area feature layer, you can choose the fill-in color 
for all the features pertaining to the layer.

In addition, you can also define the following:
- Edit the layer name
- Select which attribute to display together with the icon or 

line
- Choose a scale value above which all features pertaining 

to the layer will NOT be displayed on the Map Display 
area or on the handheld screen.

Building the Background Map
Once you are done with adding, arranging and setting layers, 
you can build the background map from these layers.
- First save the background map project using the File>Save 

command if you are happy with the project name or the 
File>Save as command if you wish to rename the back-
ground map project.
99

om Www.Somanuals.com. All Manuals Search And Download.



100

Download from
- Then click , or on the menu bar, select Operations>Cre-
ate Map. MobileMapper Office then builds the back-
ground map. A dialog box is displayed indicating that 
this operation is in progress. It disappears from the 
screen when the build operation is complete.

- Close the Create Map window. This takes you back to the 
Background Maps window where you can now attach the 
newly created background map to the open job. See 
below.

Selecting a Background Map for Display 
This function allows you to select the background map that 
you want to view in the Map Display area.

- Unless this window is already open, click  to open 
the Background Maps dialog box. This box lists the 
names of the existing background maps.

- Select the name of the background map you want to view 
and click on the Attach button. A clip icon appears before 
this name indicating that the attachment is now effective.

- Click on the Close button. This closes the dialog box and 
displays the attached background map in the Map Dis-
play area.

The following functions are also available from the Back-
ground Map dialog box:
- Create New...: Provides access to the Create Map window
- Detach: Detaches the highlighted background map from 

the job (if it’s the one currently attached to the job)
- Remove: Deletes the highlighted background map.
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Setting a Map Region
This function allows you to define the exact limits of the 
background map –shown on the Map Display area– that you 
wish to upload to the handheld. Using this function also al-
lows you to limit the file size of the uploaded portion of the 
background map for better display performance in the field.

- Click  on the toolbar, drag a rectangle around the 
desired region in the Map Display area and release the 
mouse button. The limits of the region are then repre-
sented with a rectangle with hatching on the outside. You 
can still resize or reshape the rectangle by dragging its 
control points (corner and mid-side points). You can also 
move the whole rectangle by dragging the mouse cursor 
from inside the rectangle.

- When the definition of the region is okay, click outside of 
this region. The region definition is now complete and its 
limits are now represented with a thick green line.

- If necessary, click  again (this deletes the region you 
have just defined) to redraw the region entirely.

Uploading a Background Map
After attaching a background map to the open job and possi-
bly setting a map region (see the previous two chapters), you 
can now proceed with the uploading of the background map 
to the handheld, to the PC’s hard disk or to the SD card in-
serted in the local SD card reader.
We’ll explain here how you can upload a background map. 
You have to upload jobs and background maps separately.  
Background maps are not included in the job files. Only fea-
ture libraries are actually written into job files. However, the 
names of the background maps are included with the job 
files so they can be displayed whenever you pick the job to 
display.
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- On the menu bar, select File>Upload to GPS>Background 
Map. If no Map region has been defined previously in the 
Map Display area, a message will pop up warning you 
that the whole background map is going to be uploaded. 
If you click Yes, the procedure will continue. If you click 
No, the procedure will be aborted.
In the next dialog box that opens, you have to select the 
destination of the background map. This can be the 
MobileMapper receiver (GPS Unit), the local SD Card 
reader or the PC hard disk (Hard Drive).

- Check Upload to GPS Unit and click the Next> button. If you 
have previously run the procedure described on page 70 
to test the communication with the handheld, then a new 
dialog box will be displayed reporting successful con-
nection to the handheld. Otherwise, MobileMapper 
Office will suggest that you change the settings of the PC 
port connected to the handheld.

- After successful connection to the handheld, click the 
Next> button again. A new dialog box indicates the size of 
the file to be downloaded.

- You just have to click the Finish button to let MobileMap-
per Office complete the upload operation. The following 
message is displayed while the file is being uploaded:
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The Earth is really not a
sphere but a “spheroid”

because its rotation
causes the equator to

bulge out slightly so that
the Earth's circumfer-
ence is greater around

the equator than it is
through the poles. When

looking at the Earth's
surface, however, you
are really considering

just sections of the
spheroid. And, if you

remember your geome-
try correctly, the name

for a section (slice)
taken through a spheroid

is an "ellipsoid." An
ellipsoid is to a spher-

oid as a circle is to a
sphere. Mathematician-
cartographers have his-

torically attempted to
write equations for ellip-

soids that accurately
describe the Earth's

geometry. For example,
the ellipsoid the most
commonly used today

was developed by
Clarke, in 1866.
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Coordinate System
Introduction to Coordinate Systems and Datums
The MobileMapper system uses standard coordinate systems 
and datums used by surveyors and cartographers around the 
world. MobileMapper offers the capability to define your 
own coordinate systems and datums. This involves selecting 
your own map projections, coordinate systems, and datums 
- all of which are defined below.
A map is developed using a projection that is a mathematical 
translator between the roughly spherical Earth and the flat 
map. For this reason, any map is inherently inaccurate be-
cause it must “stretch” to fit over a sphere (see comment op-
posite). This is actually quite complicated, because a map is 
flat and the Earth is not. You can demonstrate this yourself 
by taking any spherical object such as an orange and trying 
to wrap a sheet of paper around it while creating the mini-
mum of folds and wrinkles. The only way to get the paper to 
wrap evenly is to cut some sections out and stretch others.
That is what a map projection does, but in reverse. It takes 
the somewhat spherical surface of a portion of the Earth and 
flattens it while trying to avoid distortion along the way. The 
challenge is to make a projection that fits optimally through-
out the space it covers with the least distortion possible. 
There are many map projections available to the mapmaker, 
but for the most part there is only a handful in practical use 
today. MobileMapper Office software supports most of 
these common projections.
Coordinate systems describe where you are in a map projec-
tion. Some people use “grid systems” using northings and 
eastings - the distances, typically meters or feet, to the north 
and east of an agreed-upon starting point. Others work in 
geodetic coordinate systems using latitude and longitude 
numbers that divide the Earth into the degrees, minutes, and 
seconds that most people are familiar with.
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The most common coordinate systems are Universal Trans-
verse Mercator (UTM) and latitude/longitude, but there are 
many variations that are tied to specific regions of the Earth. 
MobileMapper allows you to use any of the more common 
grid coordinate systems or create your own.
Each regional system is tied to known positions within the 
region according to their positional relative to a geodetic da-
tum. According to the Geodetic Glossary (National Geodetic 
Survey, National Ocean Service, National Oceanic and At-
mospheric Administration, Rockville, MD, September 
1986) p. 54, a geodetic datum is: “A set of constants speci-
fying the coordinate system used for geodetic control, i.e., 
for calculating the coordinates of points on the Earth.” The 
key words here are “geodetic control” - the means of estab-
lishing grid or lat/lon coordinates relative to given control 
points. The datum is what is “given.” The most common ex-
amples of datums in North America are NAD27 and 
NAD83- the North American Datums of 1927 and 1983. 
Most countries have their own datums and there are also re-
gional datums for Europe and other parts of the world.
There have also been attempts to create datums for the entire 
world. The most widely used is Worldwide Geodetic System 
developed in 1984 (“WGS84”). The Global Positioning Sys-
tem, being global, uses WGS84 as a standard datum. All 
GPS receivers, including MobileMapper, calculate their po-
sitions in the lat/lon coordinate system tied into the WGS84 
datum. Users can then select other coordinate systems to dis-
play their data and other datum to define how the coordinates 
are calculated. There are many mathematical algorithms for 
“transforming” coordinates from one system to another ac-
cording to various datums.
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Which system/datum you use can have a very profound re-
sult. For example, the difference between NAD27 and 
NAD83 is minimal in Bloomington, Indiana, about 42 
meters in Albany, New York, about 70 meters in Las Vegas, 
Nevada and as much as 100 meters in parts of California. 
Why are there such differences? The NAD83 is a closer and 
more refined mathematical description of the shape of the 
Earth in North America. For this reason, the WGS84 datum 
uses elements of the NAD83 datum to calculate coordinates 
in North America.
Similar discrepancies are seen around the world when calcu-
lating positions using different datums. To make matters 
even more complicated, different organizations, govern-
ments and corporations use different algorithms to calculate 
positions for their own maps. This is not normally a problem 
as long as an organization's maps are in agreement with 
themselves. Because Thales Navigation cannot know what 
algorithm you wish to use to make MobileMapper data con-
form to the datum you are using, we export our positions in 
world standard WGS84 coordinates. This allows your GIS to 
make the transformations that are consistent with your map 
collection.
For the purposes of collecting or updating map data, both 
MobileMapper Office and MobileMapper receiver software 
will display the coordinates of features imported from your 
GIS maps in whatever datum you wish. This means that if 
you move the map cursor (in either MobileMapper Office or 
the receiver software) over a feature on a map screen, the co-
ordinate numbers (lat/lon or northing/easting) will be dis-
played in the coordinate system/datum of your choice. This 
allows you to compare the coordinates of features on a Mo-
bileMapper map with coordinates you might have in a data-
base.
105

om Www.Somanuals.com. All Manuals Search And Download.



106

Download from
However, MobileMapper uses only the WGS84 datum to 
project data onto the map screen, i.e. to position features spa-
tially on a map. One way to visualize this is if you were to 
select NAD27 or EUR79 as your datum in either Mo-
bileMapper Office or the receiver and moved the map cursor 
over a feature, you would display coordinate numbers (lat/
lon or northing/easting) that were calculated using this da-
tum. If you switched to the WGS84 datum, the coordinates 
displayed on the MobileMapper receiver's Position Screen 
or in MobileMapper Office suite's coordinate display win-
dow would change - but the position of the feature on the 
map screen would NOT change.
Why is this? Calculating coordinates doesn't take much com-
puting power but using powerful map projection algorithms 
does. Moving features around on the small map extents used 
by workers in the field does not warrant any decrease in re-
ceiver map display performance. It would take an unneces-
sary increase in time to display a map that would hardly 
change in appearance. To re-project positions on a Mo-
bileMapper Office map screen using a variety of datums 
would not be a problem for the PC and its larger screen. 
However, this is a GIS function that is outside the purpose of 
MobileMapper Office, which is designed as a GPS data 
communication, display and validating tool and not as a GIS 
in itself. Because Thales Navigation does not know what al-
gorithms your GIS uses for map projections, you should al-
ways transform MobileMapper positions using the same GIS 
you use to manage your existing maps. This is the best way 
to assure conformance of MobileMapper positions to your 
GIS maps and databases.
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Coordinate Systems in MobileMapper Office
In MobileMapper Office, the definition of a coordinate sys-
tem can be split into two different sets of parameters: hori-
zontal system and height system.
The horizontal system may be one of two types:
- Geodetic type: the system relies on the definition of a 

datum. A datum is an ellipsoid with possible linear and 
angular shifts

- Grid type: the system relies on the definition of a datum 
and a projection

The height system may be one of two types:
- Ellipsoid elevations: All elevations are calculated from 

the datum defined in the coordinate system used
- Orthometric elevations: All elevations are calculated 

from the available geoid model (EGM96 Worldwide 
Geoid model)

A large number of geodetic and grid systems are available 
for use. However, if none of these systems is suitable for 
your jobs, you can create a new one, based on the informa-
tion you have to define this system. This is described on page 
109.
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This dialog box allows
you to select a pre-

defined coordinate sys-
tem or create a new sys-

tem (refer to page 77)
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Selecting a Pre-defined Coordinate System
- On the menu bar, select Options and then Coordinate Sys-

tem. A new dialog box opens showing the name of the 
currently used coordinate system (see below).

1. Selecting an existing Geodetic system
- Click the down arrow on the right of the System Type 

combo box and highlight Geodetic (unless already 
done). Then click the down arrow on the right of the 
Geodetic Datum combo box and highlight the name of 
the desired datum. The properties of the selected 
datum can be viewed by clicking the  button located 
on the right of the Geodetic Datum combo box.

2. Selecting an existing Grid system
- Click the down arrow on the right of the System Type 

combo box and highlight Grid. Then click the down 
arrow on the right of the Grid System combo box and 
highlight the name of the desired grid system. The 
properties of the selected grid system can be viewed 
by clicking the  button located on the right of the 
Grid System combo box.

- Click the down arrow on the right of the Zone combo 
box and highlight the name of the zone correspond-
ing to your working area.
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3. Defining the height system
- In the lower part of the Coordinate System dialog box, 

check the desired option (Ellipsoid elevations or Ortho-
metric elevations). If you choose Orthometric elevations, 
the Geoid Model field just below will automatically be 
set to EGM96 Worldwide Geoid Model as this is the only 
geoid model available in MobileMapper Office.

4. Enabling the chosen coordinate system
- Click OK to close the dialog box and enable the coor-

dinate system you have just chosen.

Creating a New Coordinate System
If the coordinate system you should use for a job is not avail-
able from the list and you have the complete definition of 
this coordinate system, follow the procedure below to create 
this coordinate system in Mobile Mapper Office.
- On the menu bar, select Options and then Coordinate Sys-

tem...A new dialog box opens showing the name of the 
currently used coordinate system (see below). This dia-
log box allows you to create and select a new system.

1. Creating a new Geodetic system
- Click the down arrow on the right of the System Type 

combo box and highlight Geodetic. Then click the 
down arrow on the right of the Geodetic Datum combo 
box and highlight the first option in the list (NEW).
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You can also create a
new ellipsoid according
to the same principle as
the datum itself, i.e. by

selecting the NEW option
on top of the Ellipsoid

combo box list and then
clicking the button to

enter its characteristics.
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- Click on the  button located on the right of the Geo-
detic Datum combo box. This opens a new dialog box 
in which you should enter the name of the new datum 
and specify the ellipsoid used as well as the possible 
shifts and rotations.

- Then click OK to close this dialog box.
- Click OK again to close the Coordinate System dialog 

box and make the newly defined system the currently 
used coordinate system in MobileMapper Office.

2. Creating a new Grid system
- Click the down arrow on the right of the System Type 

combo box and highlight Grid. Then click the down 
arrow on the right of the Grid System combo box and 
highlight the first option in the list (NEW).

- Click on the  button located on the right of the Grid 
System combo box. This opens a new dialog box in 
which you should enter the name of the new grid sys-
tem (System Name field) and define the working zone 
for the grid systems as explained below.

- Click on the  button located on the right of the Zone 
combo box.
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This opens a new dialog box in which you should 
define a name, a datum, a projection and other 
parameters for this zone (see example below).

- Then click OK to close this dialog box.
- Click OK again to close the Grid System Definition dia-

log box.
- Click OK again to close the Coordinate System dialog 

box and make the newly defined system the currently 
used coordinate system in MobileMapper Office.
Note: Although MobileMapper Office allows you to 
create new coordinate systems and datums, you can-
not upload them to the receiver. This is done to pre-
serve the maximum amount of receiver memory for 
data collection. However, creating new coordinate 
systems and datums on MobileMapper Office will 
allow you to compare the data you collect in the field 
with exiting GIS data sets all in the same system/
datum.
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Print Function
MobileMapper Office’s Print function allows you to print 
the content of the Map Display area. What will be printed 
will therefore depend on which layers you will check in the 
Layers List. As most Windows applications, the Print Preview 
and Print Setup functions are available from the File menu.
Use Print Preview to adjust the map scale. The map scale con-
trol looks like a linear pot. You set the map scale by dragging 
the cursor to the desired position. The resulting scale value 
is then displayed and the content of the Map Display area is 
updated to reflect the change of scale.
Use Print Setup to set the page format and orientation and 
choose your printer.
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3. Appendices
Specifications
Receiver
- 12 parallel-channel technology, tracks up to 12 satellites 

to compute positions and update information with 
quadrifilar antenna 

Acquisition times (under optimal conditions):
- Warm: approximately 15 seconds
- Cold: approximately 1 minute
- Update Rate: 1 second continuous
Accuracy:
- Position: 7 meters, 95% 2D RMS
- With WAAS/EGNOS <3 meters, 95% 2D RMS
- Velocity: 5.1 cm/s RMS (0.1 knot) steady state 
Limits:
- Speed: 1500 km/h (951 mph)
- Altitude: 17,500 meters

Size: 6.5” x 2.9” x 1.2” (16.5 x 7.4 x 3.05 cm) (H x W x D)
Weight: 8 ounces (227 grams) with 2 AA batteries installed
Display:
- Size: 2.2”x1.75” (5.59 cm x 4.44 cm) (H x W)
- High contrast LCD with EL backlit display 
Housing:
- Weather: IEC-529 IPX7 Standard (withstands water 

immersion for >30 min. at depth of 1 m)
- Wraparound rubber armor
Temperature Ranges:
- Operating: 14°F to 140°F (-10°C to 60°C)
- Storage: -4°F to 158°F (-20°C to 70°C)

2 AA batteries or 9-35 VDC with power cable
Battery life: 8 hours with backlight and Li-ion batteries @25 
deg. C (77 deg F); 16 hours with no backlight.
Performance

Physical

Power
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Installing a Memory Card
To remove and insert an SD card:
- Turn the MobileMapper off
- Remove the battery door and then the AA batteries
- To remove the card, push the card slightly towards the 

top of the MobileMapper. You will feel a slight click 
which is the locking mechanism disconnecting and then 
you will feel the memory card pushing against your fin-
ger. Allow the SD card to slide back towards the battery 
compartment. Now carefully continue to slide the mem-
ory card out of the channel it is in and lift it out.

- To install the card, hold it with two fingers with the label 
facing you. Place the top of the SD card in the channel 
provided in the battery compartment. Carefully push the 
SD card towards the top of the unit until you feel it lock 
into place. Do not force the SD card. 

- Reinstall the batteries into the battery compartment. Be 
sure to observe the proper polarity.

- Replace the battery compartment door.
- Turn on the MobileMapper unit.
MobileMapper ships
with a 16 MB SD card,

but you can use SD cards
of any size. The addition

of the memory card to
your MobileMapper will

increase the amount of
data that can be

uploaded to it from CD-
ROM products
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Connecting MobileMapper to an External 
Device
The Data cable can be connected to MobileMapper in two 
different ways:
- MobileMapper mounted to the Mounting Cradle: Place 

the receiver in the cradle, bottom end first. Snap 
MobileMapper down until the release latch locks it in 
place. Attach the cable through the opening in the back 
of the mounting cradle. It is not necessary to tighten the 
captive screw to the receiver, although you may do so for 
added security.

- Direct connection to MobileMapper: Using the captive 
screw that is attached to the plug, tighten into the back of 
the receiver.
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Connecting MobileMapper to an External 
Power Source
If using the cable that comes with the cigarette lighter adapt-
er, simply connect it to the cigarette lighter outlet. If you 
wish to make a permanent mount to a power supply, cut the 
cable between the power supply box and the cigarette lighter 
adapter. Attach the red (+) and black (-) wires to your exter-
nal power source. The input voltage range for external power 
is 9-16 VDC.
  

Data connection pinout is as shown opposite if you look into 
the 9-pin female connector:

Pin 2: Data Out
Pin 3: Data In
Pin 5: Ground

Cable Wiring Color Code

Plug Color Signal
Power Red Power +

Black GND

Data
Yellow Data In
Orange Data Out
Black GND

Cut Here

Cigarette Lighter Adapter

Power Supply Box
9-pin Connector

Power Plug
Do not bypass the 
power supply box or 
you will damage your 
unit and void the war-

ranty.

9-Pin Connector Pinout

35 2
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Glossary
Field: Any area on MobileMapper’s screen dedicated to displaying 
the value of a parameter. Some fields are user-editable, some others 
are not.
Feature: Any element located in the field that you wish to record 
for further uploading into a GIS database for example. A feature 
can represent a real object (streetlight, park, electrical transformer, 
etc.) or on the contrary, something invisible or impalpable (gas, 
noise level, dose of fertilizer, etc.). In addition, there are four dif-
ferent types of features and each of them has its own logging pro-
cedure:
To log a feature: Means to save the characteristics of a feature into 
MobileMapper’s memory. The user is in charge of entering the de-
scription of this feature whereas the receiver is responsible for sav-
ing the GPS position(s) it has determined on this feature.
To describe a feature: Means to give each attribute of the feature 
one of the prompted values for this feature.
Attribute: A description item of a feature.
Attribute value: One of the possible values that can be ascribed to 
a feature.
Feature library: A file containing all the features relevant to a giv-
en job. Each feature is defined by a name, a certain number of pos-
sible attributes and the list of possible values for each attribute.
Nesting: This word is used to describe a feature that you are log-
ging whereas another feature is already being logged.
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Index
A
Accuracy  22
Alarm, Arrival  54
Alarm, PDOP  54
Alphabetical  40
Area feature  77
Area features, visual aspect  83
Attach, background map to job  100
Attach, feature library to job  84
Attach, waypoints and routes to job
90
Autodetect  70
B
Background map project  94
Background map, build  99
Background maps  94
Backlight, timer  56
Baud rate, serial port  58
Bearing, offset  16
Beeper  57
C
Clear, memory  57
Columns, grid feature  21
Connecting, to external device  115
Contrast  56
Coordinate system  103
Create Map editor  65
D
Datum  104
Daylight Saving  55
DBF  75
Delete, Background map  100
Deleting features  68,  83
Deleting layers  98
Deleting waypoints  92
Detach, background map  100
Direction, line or area feature offset
17
Dragging the map  67
DXF  63,  64,  75
E
Ellipsoid elevations  107
EUR79  106

F
Feature labels  66
Feature library architecture  76
Feature Library Editor  65
Feature Library, renaming  82
Files, managing  61
G
Geodetic type  107
Geometry type  79
GIS formats  63
Goto Cursor  30
Grid  66
Grid feature  77
Grid properties  87
Grid type  107
H
Heading  88
Heading, grid feature  21
Height system  107
Horizontal Distance, offset  16
Horizontal system  107
J
Job content  74
L
Languages  60
Layer List  65
Layers  97
Layers, order  98
Line feature  77
Line features, visual aspect  83
M
Map Display area  65,  66
Map region  67
Map region, setting  101
Map Scale field  96
Mark  48
Menu style  77,  81
MID  75
MIF  63,  64,  66,  75,  97
MMF  75
MMJ  69
N
NAD27  104,  106
NAD83  104
Nearest To  40
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NMEA  58
No. of attributes per feature  76
No. of attributes values per Menu-
style attribute  76
No. of features  76
Number of Columns  88
Number of Rows  88
Number of tracked satellites  22
Numeric style  77,  81
O
ON/OFF protection  59
Orthometric elevations  107
P
PDOP  22
Point feature  77
Point features, icons  82
Power off mode  56
Power source, external, connecting
116
R
Routes  67
Routes, building a route  93
Rows, grid feature  21
S
Save Track to Route  44
Scale interval  66
SD card, install, remove  114
SHP  63,  64,  66,  75,  97
SHX  75
Simulator  59
Spacing, grid feature  21
Status bar  65
Step (spacing)  88
T
Target on Map screen  24
Text style  77,  81
Track Mode  29
U
Units  53
Update Position  25
V
Vertical Distance, offset  16
W
Waypoint labels  66
WGS84  104,  105,  106

WGS84 coordinates  66
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